© OMRON, 2011

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior written permission of OMRON.

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because OMRON is constantly striving to improve its high-quality products, the information contained in this guide is subject to change without notice. Every precaution has been taken in the preparation of this guide. Nevertheless, OMRON assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the information contained in this publication.

**Trademarks**

- Sysmac and SYSMAC are trademarks or registered trademarks of OMRON Corporation in Japan and other countries for OMRON factory automation products.
- Windows, Windows XP, Windows Vista, Windows 7, and Windows 8 are registered trademarks of Microsoft Corporation in the USA and other countries.
- Intel, the Intel logo, and Intel Atom are the trademarks of Intel Corporation in the USA and other countries.
- EtherCAT® is registered trademark and patented technology, licensed by Beckhoff Automation GmbH, Germany.
- ODVA, CIP, CompoNet, DeviceNet, and EtherNet/IP are trademarks of ODVA.
- The SD and SDHC logos are trademarks of SD-3C, LLC.

Other company names and product names in this document are the trademarks or registered trademarks of their respective companies.
Thank you for purchasing an NJ-series CPU Unit and the Sysmac Studio.

This *NJ-series Startup Guide for CPU Unit* (hereafter referred to as “this Guide”) describes the startup procedures that are required to use an NJ-series CPU Unit for the first time and the basic operating instructions for the Sysmac Studio. A simple sequence control example is used for the discussion. You can perform the procedures that are presented in this Guide to quickly gain a basic understanding of the NJ-series CPU Units and the Sysmac Studio. This Guide contains information about useful NJ-series CPU Unit and Sysmac Studio features.

This Guide does not contain safety information and other details that are required for actual use of an NJ-series Controller. Thoroughly read and understand the manuals for all of the devices that are used in this Guide to ensure that the system is used safely. Review the entire contents of these materials, including all safety precautions, precautions for safe use, and precautions for correct use.

For the startup and operating instructions for motion control, refer to the *NJ-series Startup Guide for Motion Control* (Cat. No. W514).

**Intended Audience**

This Guide is intended for the following personnel, who must also have knowledge of electrical systems (an electrical engineer or the equivalent).

- Personnel in charge of introducing FA systems.
- Personnel in charge of designing FA systems.
- Personnel in charge of installing and maintaining FA systems.

**Applicable Products**

This Guide covers the following products.

- CPU Units of NJ-series Machine Automation Controllers
- Sysmac Studio Automation Software

**Special Information**

The icons that are used in this Guide are described below.

**Precautions for Safe Use**

Precautions on what to do and what not to do to ensure safe usage of the product.

**Precautions for Correct Use**

Precautions on what to do and what not to do to ensure proper operation and performance.

**Additional Information**

Additional information to read as required.

This information is provided to increase understanding or make operation easier.
Terms and Conditions Agreement

Warranty, Limitations of Liability

Warranties

- Exclusive Warranty
  Omron’s exclusive warranty is that the Products will be free from defects in materials and workmanship for a period of twelve months from the date of sale by Omron (or such other period expressed in writing by Omron). Omron disclaims all other warranties, express or implied.

- Limitations
  OMRON MAKES NO WARRANTY OR REPRESENTATION, EXPRESS OR IMPLIED, ABOUT NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE OF THE PRODUCTS. BUYER ACKNOWLEDGES THAT IT ALONE HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR INTENDED USE.

  Omron further disclaims all warranties and responsibility of any type for claims or expenses based on infringement by the Products or otherwise of any intellectual property right.

- Buyer Remedy
  Omron’s sole obligation hereunder shall be, at Omron’s election, to (i) replace (in the form originally shipped with Buyer responsible for labor charges for removal or replacement thereof) the non-complying Product, (ii) repair the non-complying Product, or (iii) repay or credit Buyer an amount equal to the purchase price of the non-complying Product; provided that in no event shall Omron be responsible for warranty, repair, indemnity or any other claims or expenses regarding the Products unless Omron’s analysis confirms that the Products were properly handled, stored, installed and maintained and not subject to contamination, abuse, misuse or inappropriate modification. Return of any Products by Buyer must be approved in writing by Omron before shipment. Omron Companies shall not be liable for the suitability or unsuitability or the results from the use of Products in combination with any electrical or electronic components, circuits, system assemblies or any other materials or substances or environments. Any advice, recommendations or information given orally or in writing, are not to be construed as an amendment or addition to the above warranty.

See http://www.omron.com/global/ or contact your Omron representative for published information.

Limitation on Liability; Etc

OMRON COMPANIES SHALL NOT BE LIABLE FOR SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR PRODUCTION OR COMMERCIAL LOSS IN ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS BASED IN CONTRACT, WARRANTY, NEGLIGENCE OR STRICT LIABILITY.

Further, in no event shall liability of Omron Companies exceed the individual price of the Product on which liability is asserted.
Application Considerations

Suitability of Use

Omron Companies shall not be responsible for conformity with any standards, codes or regulations which apply to the combination of the Product in the Buyer’s application or use of the Product. At Buyer’s request, Omron will provide applicable third party certification documents identifying ratings and limitations of use which apply to the Product. This information by itself is not sufficient for a complete determination of the suitability of the Product in combination with the end product, machine, system, or other application or use. Buyer shall be solely responsible for determining appropriateness of the particular Product with respect to Buyer’s application, product or system. Buyer shall take application responsibility in all cases.

NEVER USE THE PRODUCT FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, AND THAT THE OMRON PRODUCT(S) IS PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Programmable Products

Omron Companies shall not be responsible for the user’s programming of a programmable Product, or any consequence thereof.

Disclaimers

Performance Data

Data presented in Omron Company websites, catalogs and other materials is provided as a guide for the user in determining suitability and does not constitute a warranty. It may represent the result of Omron’s test conditions, and the user must correlate it to actual application requirements. Actual performance is subject to the Omron’s Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on improvements and other reasons. It is our practice to change part numbers when published ratings or features are changed, or when significant construction changes are made. However, some specifications of the Product may be changed without any notice. When in doubt, special part numbers may be assigned to fix or establish key specifications for your application. Please consult with your Omron's representative at any time to confirm actual specifications of purchased Product.

Errors and Omissions

Information presented by Omron Companies has been checked and is believed to be accurate; however, no responsibility is assumed for clerical, typographical or proofreading errors or omissions.
**WARRANTY**

- The warranty period for the Software is one year from the date of purchase, unless otherwise specifically agreed.
- If the User discovers defect of the Software (substantial non-conformity with the manual), and return it to OMRON within the above warranty period, OMRON will replace the Software without charge by offering media or download from OMRON’s website. And if the User discovers defect of media which is attributable to OMRON and return it to OMRON within the above warranty period, OMRON will replace defective media without charge. If OMRON is unable to replace defective media or correct the Software, the liability of OMRON and the User’s remedy shall be limited to the refund of the license fee paid to OMRON for the Software.

**LIMITATION OF LIABILITY**

- THE ABOVE WARRANTY SHALL CONSTITUTE THE USER’S SOLE AND EXCLUSIVE REMEDIES AGAINST OMRON AND THERE ARE NO OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO, WARRANTY OF MERCHANTABILITY OR FITNESS FOR PARTICULAR PURPOSE. IN NO EVENT, OMRON WILL BE LIABLE FOR ANY LOST PROFITS OR OTHER INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF USE OF THE SOFTWARE.
- OMRON SHALL HAVE NO LIABILITY FOR DEFECT OF THE SOFTWARE BASED ON MODIFICATION OR ALTERNATION TO THE SOFTWARE BY THE USER OR ANY THIRD PARTY.
- OMRON SHALL HAVE NO LIABILITY FOR SOFTWARE DEVELOPED BY THE USER OR ANY THIRD PARTY BASED ON THE SOFTWARE OR ANY CONSEQUENCE THEREOF.

**APPLICABLE CONDITIONS**

USER SHALL NOT USE THE SOFTWARE FOR THE PURPOSE THAT IS NOT PROVIDED IN THE ATTACHED USER MANUAL.

**CHANGE IN SPECIFICATION**

The software specifications and accessories may be changed at any time based on improvements and other reasons.

**ERRORS AND OMISSIONS**

The information in this manual has been carefully checked and is believed to be accurate; however, no responsibility is assumed for clerical, typographical, or proofreading errors, or omissions.
Precautions

- When building a system, check the specifications for all devices and equipment that will make up the system and make sure that the OMRON products are used well within their rated specifications and performances. Safety measures, such as safety circuits, must be implemented in order to minimize the risks in the event of a malfunction.
- Thoroughly read and understand the manuals for all devices and equipment that will make up the system to ensure that the system is used safely. Review the entire contents of these materials, including all safety precautions, precautions for safe use, and precautions for correct use.
- Confirm all regulations, standards, and restrictions that the system must adhere to.

Software Licenses and Copyrights

This product incorporates certain third party software. The license and copyright information associated with this software is available at http://www.fa.omron.co.jp/nj_info_e/.
**Related Manuals**

The followings are the manuals related to this manual. Use these manuals for reference.

<table>
<thead>
<tr>
<th>Manual name</th>
<th>Cat. No.</th>
<th>Model numbers</th>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
</table>
| NJ-series CPU Unit Hardware User’s Manual     | W500     | NJ501-xxxx     | Learning the basic specifications of the NJ-series CPU Units, including introductory information, designing, installation, and maintenance. Mainly hardware information is provided. | An introduction to the entire NJ-series system is provided along with the following information on the CPU Unit.  
  - Features and system configuration  
  - Introduction  
  - Part names and functions  
  - General specifications  
  - Installation and wiring  
  - Maintenance and inspection  
  Use this manual together with the NJ-series CPU Unit Software User’s Manual (Cat. No. W501).  
  Use this manual together with the NJ-series CPU Unit Hardware User’s Manual (Cat. No. W500). |
| NJ-series CPU Unit Software User’s Manual      | W501     | NJ501-xxxx     | Learning how to program and set up an NJ-series CPU Unit. Mainly software information is provided. | The following information is provided on a Controller built with an NJ501 CPU Unit.  
  - CPU Unit operation  
  - CPU Unit features  
  - Initial settings  
  - Programming based on IEC 61131-3 language specifications  
  Use this manual together with the NJ-series CPU Unit Hardware User’s Manual (Cat. No. W500) and NJ-series CPU Unit Software User’s Manual (Cat. No. W501). |
<p>| NJ-series CPU Unit Motion Control User’s Manual | W507     | NJ501-xxxx     | Learning about motion control settings and programming concepts. | The settings and operation of the CPU Unit and programming concepts for motion control are described. Use this manual together with the NJ-series CPU Unit Hardware User’s Manual (Cat. No. W500) and NJ-series CPU Unit Software User’s Manual (Cat. No. W501). |
| NJ-series Motion Control Instructions Reference Manual | W508 | NJ501-xxxx     | Learning about the specifications of the motion control instructions that are provided by OMRON. | The motion control instructions are described. When programming, use this manual together with the NJ-series CPU Unit Hardware User’s Manual (Cat. No. W500), NJ-series CPU User’s Manual (Cat. No. W501) and NJ-series CPU Unit Motion Control User’s Manual (Cat. No. W507). |
| NJ-series CPU Unit Built-in EtherCAT® Port User’s Manual | W505 | NJ501-xxxx     | Using the built-in EtherCAT port on an NJ-series CPU Unit. | Information on the built-in EtherCAT port is provided. This manual provides an introduction and provides information on the configuration, features, and setup. Use this manual together with the NJ-series CPU Unit Hardware User’s Manual (Cat. No. W500) and NJ-series CPU Unit Software User’s Manual (Cat. No. W501). |
| NJ-series CPU Unit Built-in EtherNet/IP™ Port User’s Manual | W506 | NJ501-xxxx     | Using the built-in EtherNet/IP port on an NJ-series CPU Unit. | Information on the built-in EtherNet/IP port is provided. Information is provided on the basic setup, tag data links, and other features. Use this manual together with the NJ-series CPU Unit Hardware User’s Manual (Cat. No. W500) and NJ-series CPU Unit Software User’s Manual (Cat. No. W501). |</p>
<table>
<thead>
<tr>
<th>Manual name</th>
<th>Cat. No.</th>
<th>Model numbers</th>
<th>Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NJ-series Troubleshooting Manual</td>
<td>W503</td>
<td>NJ501-3333, 3334, 3335, 3336</td>
<td>Learning about the errors that may be detected in an NJ-series Controller.</td>
<td>Concepts on managing errors that may be detected in an NJ-series Controller and information on individual errors are described. Use this manual together with the NJ-series CPU Unit Hardware User's Manual (Cat. No. W500) and NJ-series CPU Unit Software User's Manual (Cat. No. W501).</td>
</tr>
<tr>
<td>Sysmac Studio Version 1 Operation Manual</td>
<td>W504</td>
<td>SYSMAC-SE2</td>
<td>Learning about the operating procedures and functions of the Sysmac Studio.</td>
<td>Describes the operating procedures of the Sysmac Studio.</td>
</tr>
<tr>
<td>NJ-series Startup Guide for Motion Control</td>
<td>W514</td>
<td>NJ501-3333, 3334, 3335, 3336, SYSMAC-SE2</td>
<td>Learning startup procedures and Sysmac Studio operating procedures for someone that will use NJ-series motion control functions for the first time.</td>
<td>Describes the operations from hardware assembly through debugging for axis parameter settings, simple one-axis positioning, and two-axis linear interpolation.</td>
</tr>
</tbody>
</table>
A manual revision code appears as a suffix to the catalog number on the front and back covers of the manual.

**Revision History**

<table>
<thead>
<tr>
<th>Revision code</th>
<th>Date</th>
<th>Revised content</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>November 2011</td>
<td>Original production</td>
</tr>
<tr>
<td>02</td>
<td>February 2014</td>
<td>Made changes accompanying release of new versions of the CPU Units and Sysmac Studio.</td>
</tr>
</tbody>
</table>
Features of an NJ-series CPU Unit

The SYSMAC NJ-series Controllers are next-generation machine automation controllers that provide the functionality and high-speed performance that are required for machine control. They provide the safety, reliability, and maintainability that are required of industrial controllers.

The NJ-series Controllers provide the functionality of previous OMRON PLCs, and they also provide the functionality that is required for motion control. Synchronized control of I/O devices on high-speed EtherCAT can be applied to vision systems, motion equipment, discrete I/O, and more.

### High-speed, High-precision Control

An Intel® Atom™ processor enables high-speed execution of the user program. Ladder diagram instructions are executed as quickly as 1.9 ns. Double-precision floating-point calculation instructions are executed as quickly as 26 ns.

### Integrated Sequence Control and Motion Control

An NJ-series CPU Unit can perform both sequence control and motion control. This eliminates the communications time loss between the CPU Unit and the Position Control Units and simplifies the communications setup.

Furthermore, a diverse, PLCopen-compliant Motion Control Function Block provides the ability to perform complex cam motion and multi-axis coordinated control operations.

### Standard-feature EtherCAT Control Network Support

All CPU Units provide an EtherCAT master port for EtherCAT communications.

EtherCAT is an advanced industrial network system that achieves faster, more-efficient communications. It is based on Ethernet. Each node achieves a short fixed communications cycle time by transmitting Ethernet frames at high speed.

Standard-feature EtherCAT allows you to connect all of the devices required for machine control (e.g., I/O systems, Servo Drives, Inverters, and machine vision) to the same network.

### Standard-feature EtherNet/IP Communications Port

All CPU Units provide an EtherNet/IP port for EtherNet/IP communications. EtherNet/IP is a multivendor industrial network that uses Ethernet. You can use it for networks between Controllers or as a field network. The use of standard Ethernet technology allows you to connect to many different types of general-purpose Ethernet devices.
Programming Languages Based on the IEC 61131-3 International Standard

The NJ-series Controllers support language specifications that are based on IEC 61131-3. To these, OMRON has added our own improvements.

You can use motion control instructions that are based on PLCopen standards and an instruction set (POUs) that follows IEC standards.

Programming with Variables to Eliminate Worrying about the Memory Map

You access all data through variables in the same way as for the advanced programming languages that are used on computers.

When you create variables, memory in the CPU Unit is automatically assigned to them so that you do not have to be concerned with the memory map. This keeps software modifications to a minimum even when there are changes in the hardware configuration.

Multitasking

Series of processes including I/O refreshing and program execution are assigned to tasks, and then the execution conditions and the order of execution are set for the tasks. Many tasks can be combined to flexibly build a control system that is matched to the application.

A Wealth of Security Features

You can use the many security features of the NJ-series Controllers, including operation authority settings and restriction of program execution with IDs.

Complete Controller Monitoring

The CPU Unit monitors events in all parts of the Controller, including mounted Units and EtherCAT slaves. Troubleshooting methods for errors that are generated as events are displayed on the Sysmac Studio or on an NS-series PT. Events are also recorded in logs.

Sysmac Studio Automation Software

The Sysmac Studio provides an integrated development environment that covers not only the Controller, but also covers peripheral devices and devices on EtherCAT. You can use integrated operations regardless of the device. You can use the Sysmac Studio in all phases of Controller application, from designing through debugging, simulations, commissioning, and changes during operation.

A Wealth of Simulation Features

The many simulation features include execution, debugging, and task execution time estimates on a virtual controller.
## CONTENTS

### Section 1  System Configuration and Startup Procedures

1-1 Startup Procedures ................................................................. 1-2
1-2 System Configuration and Configuration Devices ................. 1-3
1-3 User Program to Create ......................................................... 1-5

### Section 2  Fundamentals of Programming

2-1 POUs (Program Organization Units) .................................... 2-2
2-2 Variables ............................................................................ 2-3
2-3 Tasks .................................................................................. 2-4
2-4 Programming Languages .................................................... 2-5
2-5 Instructions ........................................................................ 2-6

### Section 3  Before You Begin

3-1 Installing the Sysmac Studio ............................................. 3-2
3-2 Assembling the Hardware .................................................. 3-3
3-2-1 Mounting the Units ......................................................... 3-3
3-2-2 Setting the Node Address for the Digital I/O Slave Units .... 3-4
3-2-3 Wiring the Power Supply .................................................. 3-4
3-2-4 Laying EtherCAT Communications Cables ..................... 3-5
3-2-5 Wiring the Digital I/O Slave Units to the Power Supply .... 3-5

---

### Introduction

- Intended Audience ................................................................. 1
- Applicable Products ............................................................... 1
- Special Information ............................................................... 1

### Terms and Conditions Agreement

- Warranty, Limitations of Liability ........................................ 2
- Application Considerations .................................................. 3
- Disclaimers ........................................................................... 3

### Precautions

- Software Licenses and Copyrights ........................................ 5

### Related Manuals

- ....................................................................................... 6

### Revision History

- ....................................................................................... 8

### Features of an NJ-series CPU Unit

- ....................................................................................... 9
Section 4 Programming and Debugging

4-1 Procedures .................................................................................................................. 4-2
4-2 Creating a Project .......................................................................................................... 4-3
4-3 Programming ................................................................................................................. 4-6
  4-3-1 Defining the Global Variables ..................................................................................... 4-6
  4-3-2 Writing the Algorithm .............................................................................................. 4-8
4-4 Creating the EtherCAT Network Configuration ............................................................. 4-18
4-5 Connecting the Device I/O Information to the Program.............................................. 4-20
4-6 Debugging the Program .................................................................................................. 4-21
  4-6-1 Preparations for Online Debugging ............................................................................. 4-21
  4-6-2 Preparations for Offline Debugging ........................................................................... 4-27
  4-6-3 Debugging Program Logic ......................................................................................... 4-30
  4-6-4 Using a Data Trace to Confirm the Operation of the Indicators ................................ 4-39
  4-6-5 Modifying the Logic with Online Editing ................................................................. 4-43

Section 5 Useful Functions

5-1 Registering and Managing Application Events .............................................................. 5-2
5-2 Protecting User Program Assets .................................................................................... 5-5
  5-2-1 Preventing Theft with Authentication of User Program Execution IDs .................. 5-5
  5-2-2 Preventing Theft By Transferring without User Program Restoration Information ... 5-6
  5-2-3 Protecting User Asset Information with Overall Project File Protection ............... 5-6
  5-2-4 Using Data Protection to Protect User Asset Information ....................................... 5-6
  5-2-5 Preventing Incorrect Operation with Operation Authority Verification ............... 5-7
  5-2-6 Preventing Write Operations from the Sysmac Studio with Write Protection ......... 5-9
  5-2-7 Using CPU Unit Names to Prevent Incorrect Connections from the Sysmac Studio... 5-9

Appendices

A-1 Using Cross References ............................................................................................... A-2
A-2 Useful Functions for Editing Variable Tables ............................................................... A-5
A-3 Frequently Used Programming Operations ............................................................... A-8
A-4 Creating an Online Network Configuration ................................................................. A-15
A-5 Differences between Online and Offline Debugging ................................................ A-17
A-6 Forced Refreshing on the I/O Map ............................................................................... A-18
System Configuration and Startup Procedures

This section describes the startup procedures that are presented, the system configuration that is used, and the operation of the program that is created in this Guide.

1-1  Startup Procedures ................................................................. 1-2
1-2  System Configuration and Configuration Devices .......................... 1-3
1-3  User Program to Create ........................................................... 1-5
### 1-1 Startup Procedures

This Guide describes the basic procedures from programming to debugging. All operations from programming to debugging can be performed under the following system configurations.

<table>
<thead>
<tr>
<th>System configuration</th>
<th>Operation details</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Sysmac Studio</td>
<td>You create the program on the Sysmac Studio, go online with the CPU Unit, and then debug the program. During programming, you create the program and connect the I/O information for the Digital I/O Slave Units with the program.</td>
</tr>
<tr>
<td>• CPU Unit</td>
<td></td>
</tr>
<tr>
<td>• Digital I/O Slave Units</td>
<td></td>
</tr>
<tr>
<td>• Sysmac Studio</td>
<td>You create the program on the Sysmac Studio, go online with the CPU Unit, and then debug the program. Digital I/O Slave Units are not used, so programming involves only creating the program.</td>
</tr>
<tr>
<td>• CPU Unit</td>
<td></td>
</tr>
<tr>
<td>• Sysmac Studio</td>
<td>You perform all tasks from programming to debugging by using just the Sysmac Studio. During programming, you create the program and connect the I/O information for the Digital I/O Slave Units with the program. Debugging is performed with the Simulator. The Simulator allows you to debug on the computer a program that was created for the actual system configuration.</td>
</tr>
<tr>
<td>• CPU Unit</td>
<td></td>
</tr>
</tbody>
</table>

The startup procedures for each of these system configurations is outlined in the following figure.

![Diagram of Startup Procedures](image-url)
1-2 System Configuration and Configuration Devices

The following figure represents the system configurations that are used in this Guide. If a CPU Unit is used, connect a computer with the Sysmac Studio installed to the peripheral USB port on the CPU Unit. If Digital I/O Slave Units are used, connect the Digital I/O Slave Units to the CPU Unit’s built-in EtherCAT port.

The models of the devices that are used in each of the above system configurations are given below. When selecting devices for an actual application, refer to the device manuals.

<table>
<thead>
<tr>
<th>Device name</th>
<th>Model numbers</th>
<th>Manual name</th>
</tr>
</thead>
<tbody>
<tr>
<td>NJ-series CPU Unit</td>
<td>NJ501-1500 (unit version 1.00)</td>
<td>NJ-series CPU Unit Hardware User’s Manual (Cat. No. W500)</td>
</tr>
<tr>
<td>NJ-series Power Supply Unit</td>
<td>NJ-PA3001</td>
<td></td>
</tr>
<tr>
<td>EtherCAT Communications Cables</td>
<td>XS5W-T421-CMD-K</td>
<td></td>
</tr>
<tr>
<td>Digital I/O Slave Units</td>
<td>GX-ID1611 (version 1.1) and GX-OD1611 (version 1.1)</td>
<td>GX-series EtherCAT Slave Units User’s Manual (Cat. No. W488)</td>
</tr>
<tr>
<td>Unit power supplies*1</td>
<td>S8JX Series</td>
<td></td>
</tr>
<tr>
<td>USB cable</td>
<td>Commercially available USB cable*2</td>
<td></td>
</tr>
</tbody>
</table>

*1. The Unit power supplies are used for the Digital I/O Slave Units.
*2. Use a USB 2.0 (or 1.1) cable (A connector - B connector), 5.0 m max.
### Automation Software

<table>
<thead>
<tr>
<th>Product</th>
<th>Number of licenses</th>
<th>Model numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sysmac Studio Standard Edition version 1.0</td>
<td>None (DVD only)</td>
<td>SYSMAC-SE200D</td>
</tr>
<tr>
<td></td>
<td>1 license</td>
<td>SYSMAC-SE201L</td>
</tr>
</tbody>
</table>
1-3 User Program to Create

The startup procedures are used to create a program for sequence control with switches and indicators. This programming example assumes that pushbutton switches are wired as inputs to a Digital I/O Slave Unit and that indicators are wired to a Digital I/O Slave Unit as outputs. The switches control the indicators. However, because we only need to confirm the operation of the variables in the program, you do not need to prepare any actual switches or indicators for this example.

- When the yellow pushbutton switch is turned ON, the yellow indicator lights.
- When the yellow pushbutton switch is turned OFF, the yellow indicator does not go out.
- When the red pushbutton switch is turned ON, the yellow indicator goes out.

Controlling the Yellow Indicator (Self-holding Rung)

Controlling the Green Indicator (ON-delay Timer)

- When the green pushbutton switch is turned ON, the green indicator lights 3 seconds later.
- When the green pushbutton switch is turned ON and then turned OFF again within 3 seconds, the green indicator does not light.
- When the green pushbutton switch is turned OFF while the green indicator is lit, the green indicator goes out.
1 System Configuration and Startup Procedures
# Fundamentals of Programming

This section describes the fundamental elements of programming an NJ-series CPU Unit: POUs, variables, tasks, programming languages, and instructions.

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-1</td>
<td>POUs (Program Organization Units)</td>
<td>2-2</td>
</tr>
<tr>
<td>2-2</td>
<td>Variables</td>
<td>2-3</td>
</tr>
<tr>
<td>2-3</td>
<td>Tasks</td>
<td>2-4</td>
</tr>
<tr>
<td>2-4</td>
<td>Programming Languages</td>
<td>2-5</td>
</tr>
<tr>
<td>2-5</td>
<td>Instructions</td>
<td>2-6</td>
</tr>
</tbody>
</table>
A POU (program organization unit) is a unit that is defined in the IEC 61131-3 user program execution model. You combine POUs to build a complete user program.

There are three types of POUs, as described below.

<table>
<thead>
<tr>
<th>POU configuration element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Programs</td>
<td>A program corresponds to a main routine. It is the main type of POU that is used for algorithms. You can place any instruction, function, or function block in the algorithm of a program.</td>
</tr>
<tr>
<td>Function Blocks (FBs)</td>
<td>A function block can output different values even with the same inputs. Function blocks are executed when they are called from a program or another function block. To use a function block in a program, an instance of the function block must be placed in the program. You can retain the values of internal variables. Therefore, you can retain status, such as for timers and counters.</td>
</tr>
<tr>
<td>Functions (FUNs)</td>
<td>A function always outputs the same values for the same inputs. Functions are executed when they are called from a program, another function, or a function block.</td>
</tr>
</tbody>
</table>

### Easy-to-Read Programming

Programs can be organized in layers by calling POUs from other POUs. For example, you can increase the readability of your programs by structuring them according to units of control.

The following figure shows the structure for a conveyor control program and processing control program as examples.

![Conveyor Control Program](image1)

![Processing Control Program](image2)

### Reusable Programming

Function blocks and functions are used to divide programs into smaller, more manageable objects. If processes are divided up into function blocks, you can call instances of those function blocks to reuse them in other devices that require those same processes.
2-2 Variables

Variables store I/O data for exchange with external devices or temporary data that is used for internal POU processing. In the NJ-series System, variables are used to exchange I/O information with external devices, to perform data calculations, and to perform other processes. This allows for programming that does not depend on hardware memory addresses.

Local Variables and Global Variables

You can read and write a local variable only from the POU in which you defined it. However, you can read and write global variables from any POU (i.e., any program, function, or function block). This Guide defines the variables that are required to access the pushbutton switches and indicators as global variables. The variables that are used in self-holding rungs are defined as local variables.

Variable Data Types

The Data Type attribute defines the type of data and range of data that are expressed by a variable. To define a variable, you must specify its data type.

NJ-series Controllers provide the predefined basic data types that are listed in the following table. There are also derivative data types, which are defined by the user.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Definition</th>
<th>Data types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>A data type with a value of either TRUE or FALSE.</td>
<td>BOOL</td>
</tr>
<tr>
<td>Bit strings</td>
<td>A data type that represents a value as a bit string.</td>
<td>BYTE, WORD, DWORD, and LWORD</td>
</tr>
<tr>
<td>Integers</td>
<td>A data type that represents an integer value.</td>
<td>SINT, INT, DINT, LINT, USINT, UINT, UDINT, and ULINT</td>
</tr>
<tr>
<td>Real numbers</td>
<td>A data type that represents a real number.</td>
<td>REAL and LREAL</td>
</tr>
<tr>
<td>Durations</td>
<td>A data type that represents a time duration (days, hours, minutes, seconds, and milliseconds).</td>
<td>TIME</td>
</tr>
<tr>
<td>Times of day</td>
<td>A data type that represents a specific time of day (hour, minutes, and seconds).</td>
<td>DATE</td>
</tr>
<tr>
<td>Dates</td>
<td>A data type that represents a date (year, month, and day).</td>
<td>TIME_OF_DAY</td>
</tr>
<tr>
<td>Dates and times</td>
<td>A data type that represents a date and time (year, month, day, hour, minutes, seconds, and milliseconds).</td>
<td>DATE_AND_TIME</td>
</tr>
<tr>
<td>Text strings</td>
<td>A data type that contains a value that represents a text string.</td>
<td>STRING</td>
</tr>
</tbody>
</table>
## 2-3 Tasks

Tasks are used to assign execution conditions and execution priorities to programs and to I/O refreshing. Programs are executed by assigning them to a task.

There are three types of tasks, as described in the following table.

<table>
<thead>
<tr>
<th>Type of task</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary periodic task</td>
<td>The primary periodic task is executed once every task period. The primary periodic task has the highest execution priority. It executes processes with high speed and high precision.</td>
</tr>
<tr>
<td>Periodic task</td>
<td>A periodic task is executed once every task period. These tasks have a lower execution priority than the primary periodic task. Periodic tasks are executed during the unused time between executions of the primary periodic task.</td>
</tr>
<tr>
<td>Event tasks*1</td>
<td>An event task is executed only once when the specified execution condition is met. Execution of event tasks is interrupted for execution of the primary periodic task and for periodic tasks that have a higher execution priority.</td>
</tr>
</tbody>
</table>

*1. A CPU Unit with unit version 1.03 or later and Sysmac Studio version 1.04 or higher are required to use event tasks.

The program in this Guide is executed in the primary periodic task. The Sysmac Studio default value of 1 ms is used as the task period. This setting does not need to be changed.
2-4 Programming Languages

The languages that are used to express the algorithms in POUs are called the programming languages. There are two different programming languages that you can use for an NJ-series Controller: ladder diagram language (LD) and structured text language (ST).

- Ladder Diagrams

The ladder diagram language (LD) is a graphical programming language that is written in a form that appears similar to electrical circuits. Each object for processing, including functions and function blocks, is represented as a diagram. Those objects are connected together with lines to build the algorithm. Algorithms that are written in the ladder diagram language are called ladder diagrams.

- Structured Text

The ST language is a high-level language for industrial controls (mainly PLCs). It is defined by the IEC 61131-3 standard.

The standard control statements, operators, and functions make the ST language ideal for mathematical processing, which is difficult to write in ladder diagrams.

The programming examples in this Guide use ladder diagrams because they are ideal for sequence control.
Instructions are the smallest unit of the processing elements that are provided by OMRON for use in POU algorithms.

Instructions are classified as shown below.

<table>
<thead>
<tr>
<th>Type of instruction</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ladder diagram structure elements (inputs and outputs)</td>
<td>These instructions take the form of a program input or program output. These are used in ladder diagrams.</td>
</tr>
<tr>
<td>FB instructions</td>
<td>These instructions are created with a function block. An instruction that retains status within the instruction, such as timers or counters, is written as an FB instruction. To use an FB instruction in a program, an instance of the instruction must be placed in the program.</td>
</tr>
<tr>
<td>FUN instructions</td>
<td>These instructions are created with a function. Instructions that always output the same values for the same inputs are written as function instructions.</td>
</tr>
<tr>
<td>ST language statements</td>
<td>These include instructions that take the form of ST constructs, such as IF or FOR constructs, and simple ST statements, such as assignments and operators. These instructions are used in the ST language.</td>
</tr>
</tbody>
</table>
Before You Begin

This section describes the installation of the Sysmac Studio and the process of hardware mounting and wiring.

<table>
<thead>
<tr>
<th>3-1 Installing the Sysmac Studio</th>
<th>3-2 Assembling the Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-2-1 Mounting the Units</td>
<td>3-2-1 Mounting the Units</td>
</tr>
<tr>
<td>3-2-2 Setting the Node Address for the Digital I/O Slave Units</td>
<td>3-2-2 Setting the Node Address for the Digital I/O Slave Units</td>
</tr>
<tr>
<td>3-2-3 Wiring the Power Supply</td>
<td>3-2-3 Wiring the Power Supply</td>
</tr>
<tr>
<td>3-2-4 Laying EtherCAT Communications Cables</td>
<td>3-2-4 Laying EtherCAT Communications Cables</td>
</tr>
<tr>
<td>3-2-5 Wiring the Digital I/O Slave Units to the Power Supply</td>
<td>3-2-5 Wiring the Digital I/O Slave Units to the Power Supply</td>
</tr>
</tbody>
</table>
3-1 Installing the Sysmac Studio

The Sysmac Studio is the Support Software that you use for an NJ-series Controller. On it, you can create the Controller configuration and settings, you can write the programs, and you can debug and simulate operation.

Use the following procedure to install the Sysmac Studio.

1. Set the Sysmac Studio installation disk into the DVD-ROM drive.
   The setup program is started automatically and the Select Setup Language Dialog Box is displayed.

2. Select the language to use, and then click the **OK** Button.
   The Sysmac Studio Setup Wizard is started.

3. Follow the instructions given by the Setup Wizard to complete the installation.

4. Restart the computer when the installation is completed.

**Additional Information**

- The system requirements for the Sysmac Studio are given in the following table.

<table>
<thead>
<tr>
<th>OS</th>
<th>CPU</th>
<th>RAM</th>
<th>Display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP SP3, Windows Vista, Windows 7 (32-bit or 64-bit edition), or Windows 8 (32-bit or 64-bit edition)</td>
<td>Minimum IBM AT or compatible with Celeron 540 (1.8 GHz) processor</td>
<td>2 GB</td>
<td>XGA 1,024 × 768, 16 million colors</td>
</tr>
<tr>
<td></td>
<td>Recommended IBM AT or compatible with Core i5 M520 (2.4 GHz) processor or the equivalent</td>
<td>2 GB</td>
<td>WXGA 1,280 × 800, 16 million colors</td>
</tr>
</tbody>
</table>

- Refer to the *Sysmac Studio Version 1 Operation Manual* (Cat. No. W504) if you are unable to install the Sysmac Studio with the above instructions.

**Precautions for Correct Use**

If CX-One version 4 or lower is installed, the installation is cancelled and the Sysmac Studio cannot be installed. In that case, uninstall the CX-One before you install the Sysmac Studio.
3-2 Assembling the Hardware

Connect and wire all of the devices that are used in the system configuration. This section gives an overview of the assembly procedures. Refer to the device manuals for detailed procedures and safety precautions.

Precautions for Safe Use

Always turn OFF the power supply to the Controller and the Units before you attempt any of the following.
- Mounting or removing any Units
- Assembling a Rack
- Setting DIP switches or rotary switches
- Connecting cables or wiring the system
- Connecting or disconnecting the connectors

The Power Supply Unit continues to supply power to the Controller for up to several seconds after the power supply is turned OFF. The PWR indicator remains lit as long as power is supplied. Make sure that the PWR indicator is not lit before you perform any of the above operations.

3-2-1 Mounting the Units

Connect the Power Supply Unit, CPU Unit, and End Cover.

After joining the connectors between the Units, use the sliders at the top and bottom of each Unit to lock the Units together. Lock the sliders firmly into place.
3-2-2 Setting the Node Address for the Digital I/O Slave Units

Set the node address for the Digital I/O Slave Units as shown below.

![Rotary switches for setting the node address]

GX-ID1611

10s digit
Set to 0.

1s digit
Set to 1.

GX-OD1611

10s digit
Set to 0.

1s digit
Set to 2.

3-2-3 Wiring the Power Supply

Wire the Power Supply Unit to the power supply.

![M4 self-raising screw terminals]

* The RUN output is ON when the CPU Unit is in RUN mode. It is OFF when the CPU Unit is in PROGRAM mode or when a major fault level Controller error occurs.

Additional Information

This Guide uses an NJ-PA3001 AC Power Supply Unit. An NJ-PD3001 DC Power Supply Unit can also be used.
3-2-4 Laying EtherCAT Communications Cables

Connect the EtherCAT slave communications cable to the built-in EtherCAT port as shown in the following figure.

Connect the communications cable from the built-in EtherCAT port to the input port on the first slave, and then connect the communications cable to the next slave to the output port on the first slave.

Do not connect anything to the output port of the slave at the end of the network.

3-2-5 Wiring the Digital I/O Slave Units to the Power Supply

Connect the cable from the Unit power supply for the Slaves (24 VDC) to the power supply connector on each Slave.
Programming and Debugging

This section describes the basic procedures for programming and debugging.

4-1 Procedures ......................................................... 4-2
4-2 Creating a Project .................................................. 4-3
4-3 Programming ....................................................... 4-6
   4-3-1 Defining the Global Variables ............................. 4-6
   4-3-2 Writing the Algorithm .............................. 4-8
4-4 Creating the EtherCAT Network Configuration .................. 4-18
4-5 Connecting the Device I/O Information to the Program .......... 4-20
4-6 Debugging the Program ........................................ 4-21
   4-6-1 Preparations for Online Debugging ....................... 4-21
   4-6-2 Preparations for Offline Debugging ....................... 4-27
   4-6-3 Debugging Program Logic ................................. 4-30
   4-6-4 Using a Data Trace to Confirm the Operation of the Indicators 4-39
   4-6-5 Modifying the Logic with Online Editing .................. 4-43
4-1 Procedures

This section provides the basic operating procedures for programming and debugging. NJ-series Controllers support programming with variables, so there is no need for concern about memory addresses. Therefore, hardware and software can be designed independently and developed in parallel.

This Guide describes the programming procedures that are used when the physical system is not yet connected so that you will understand the concepts of programming with variables.

**STEP 1. Create a Project (page 4-3)**
Create a project file.

**STEP 2. Start Programming (page 4-6)**
Define the global variables and create the POUs.

- **STEP 2-1 Define the global variables (page 4-6).**
- **STEP 2-2 Write the algorithms (page 4-8).**

**STEP 3. Create the EtherCAT Network Configuration (page 4-18)**
Create the Digital I/O Slave Unit configuration that will connect to the CPU Unit’s built-in EtherCAT port.

**STEP 4. Connect the Device I/O Information to the Program (page 4-20)**
Assign the I/O information of the Digital I/O Slave Units to the program variables.

**STEP 5. Debug the Program (page 4-21)**
Transfer the project to the CPU Unit and check operation with online debugging. If an actual CPU Unit is not used, run a simulation in the Sysmac Studio to check the operation of the program with offline debugging.

- **STEP 5-1 Prepare for online debugging (page 4-21).**
- **STEP 5-2 Prepare for offline debugging (page 4-27).**
- **STEP 5-3 Debug the program logic (page 4-30).**
- **STEP 5-4 Use a data trace to confirm the operation of the indicators (page 4-39).**
- **STEP 5-5 Modify the logic as needed with online editing (page 4-43).**
4-2 Creating a Project

Start the Sysmac Studio and create a project.

Starting the Sysmac Studio

Start the Sysmac Studio.

1. Use one of the following methods to start the Sysmac Studio.
   - Double-click the Sysmac Studio shortcut icon on your desktop.
   - Select **All Programs – OMRON – Sysmac Studio – Sysmac Studio** from the Windows Start Menu.

The Sysmac Studio starts and the following window is displayed.
Creating a Project

Create a project in Sysmac Studio.

1. Click the **New Project** Button in the Project Window.

2. Enter the project name, author, and comment in the Project Properties Dialog Box, select the device category and the device to use, and then click the **Create** Button. (Only the project name is required.)

A project file is created and the following window is displayed.

This concludes the procedure to create a project file.
### Additional Information

The names and functions of the parts of the Sysmac Studio Window are shown in the following figure.

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1)</td>
<td>Multiview Explorer</td>
<td>This pane is your access point for all Sysmac Studio data. It is separated into Configurations and Setup and Programming Layers.</td>
</tr>
<tr>
<td>(2)</td>
<td>Filter Pane</td>
<td>The Filter Pane allows you to search for color codes and for items with an error icon. The results are displayed in a list.</td>
</tr>
<tr>
<td>(3)</td>
<td>Edit Pane</td>
<td>The Edit Pane is used to display and edit the data for any of the items. It is separated into Configurations and Setup and Programming Layers.</td>
</tr>
<tr>
<td>(4)</td>
<td>Toolbox</td>
<td>The Toolbox shows the objects that you can use to edit the data that is displayed in the Edit Pane.</td>
</tr>
<tr>
<td>(5)</td>
<td>Search and Replace Pane</td>
<td>In this pane, you can search for and replace strings in the data in the Programming Layer.</td>
</tr>
<tr>
<td>(6)</td>
<td>Controller Status Pane</td>
<td>The Controller Status Pane shows the current operating status of the Controller. The Controller Status Pane is displayed only while the Sysmac Studio is online with the Controller.</td>
</tr>
<tr>
<td>(7)</td>
<td>Simulation Pane</td>
<td>The Simulation Pane is used to set up, start, and stop the Simulator for the Controller.</td>
</tr>
<tr>
<td>(8)</td>
<td>Cross Reference Tab Page</td>
<td>A Cross Reference Tab Page displays a list of where variables, data types, I/O ports, functions, and function blocks are used in the Sysmac Studio.</td>
</tr>
<tr>
<td>(9)</td>
<td>Output Tab Page</td>
<td>The Output Tab Page shows the results of building.</td>
</tr>
<tr>
<td>(10)</td>
<td>Watch Tab Page</td>
<td>The Watch Tab Page shows the monitor results of the Simulator or online Controller.</td>
</tr>
<tr>
<td>(11)</td>
<td>Build Tab Page</td>
<td>The Build Tab Page shows the results of program checks and building.</td>
</tr>
<tr>
<td>(12)</td>
<td>Search and Replace Results Tab Page</td>
<td>The Search and Replace Results Tab Page shows the results when Search All or Replace All is executed.</td>
</tr>
</tbody>
</table>

Refer to the *Sysmac Studio Version 1 Operation Manual* (Cat. No. W504) for details on the Sysmac Studio panes and tab pages.
4-3 Programming

The following programming is created.

- **Controlling the Yellow Indicator (Self-holding Rung)**
  - When the yellow pushbutton switch is turned ON, the yellow indicator lights.
  - When the yellow pushbutton switch is turned OFF, the yellow indicator does not go out.
  - When the red pushbutton switch is turned ON, the yellow indicator goes out.

- **Controlling the Green Indicator (ON-delay Timer)**
  - When the green pushbutton switch is turned ON, the green indicator lights 3 seconds later.
  - When the green pushbutton switch is turned ON and then turned OFF again within 3 seconds, the green indicator does not light.
  - When the green pushbutton switch is turned OFF while the green indicator is lit, the green indicator goes out.

**Additional Information**

The Sysmac Studio provides an environment for programming with variables. This enables you to program without having to think about the actual system configurations.

### 4-3-1 Defining the Global Variables

Define the global variables that are required to access the pushbutton switches and indicators. The global variables to define are listed in the following table.

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Data type</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>SwYellow</td>
<td>BOOL</td>
<td>Yellow pushbutton switch</td>
</tr>
<tr>
<td>SwRed</td>
<td>BOOL</td>
<td>Red pushbutton switch</td>
</tr>
<tr>
<td>SwGreen</td>
<td>BOOL</td>
<td>Green pushbutton switch</td>
</tr>
<tr>
<td>LmpYellow</td>
<td>BOOL</td>
<td>Yellow indicator</td>
</tr>
<tr>
<td>LmpGreen</td>
<td>BOOL</td>
<td>Green indicator</td>
</tr>
</tbody>
</table>

1. Double-click **Global Variables** under **Programming** – **Data** in the Multiview Explorer.

2. Click inside the global variable table.
Define the SwYellow variable.

3. Enter the variable name in the Name Field.

Enter SwYellow.

Press the Enter Key to confirm.

The data type field does not need to be changed because the default BOOL data type is used for this example.

This concludes the definition of the SwYellow variable.

Next, define the SwRed variable.

4. Press the Insert Key in the global variable table, or right-click in the global variable table and select Create New from the menu.

Press the Insert Key in the global variable table, or right-click in the global variable table and select Create New from the menu.

Enter SwRed, and then press the Enter Key to confirm.

The SwGreen, LmpYellow, and LmpGreen variables are defined by following this same procedure.

5. Define the SwGreen, LmpYellow, and LmpGreen variables by following this same procedure.

Enter SwYellow.

Press the Enter Key to confirm.

The SwRed variable is defined by following this same procedure.

This concludes the definition of the global variables.
### 4-3-2 Writing the Algorithm

Create the program algorithms. The algorithm is written in Section0 of Program0. Program0 is automatically created when you create a project.

Create the algorithm.

![Control for yellow indicator (self-holding rung)](image1)

![Control for green indicator (on-delay timer)](image2)

### Opening the Ladder Editor

Open the Ladder Editor to create the algorithms required.

1. Double-click Section0 under Programming − POUs − Programs − Program0 in the Multiview Explorer.

![Multiview Explorer](image3)

The Ladder Editor for Section0 is displayed.

![Ladder Editor](image4)
Creating the Algorithm for Controlling the Yellow Indicator (Self-holding Rung)

Create the algorithm.

- When the yellow pushbutton switch is turned ON, the yellow indicator lights.
- When the yellow pushbutton switch is turned OFF, the yellow indicator does not go out.
- When the red pushbutton switch is turned ON, the yellow indicator goes out.

The yellow indicator should stay lit even when the yellow pushbutton switch is turned OFF. In this case, a self-holding rung is used.

Here, shortcut keys are used to create the algorithm. The Sysmac Studio also provides the following ways to create algorithms.

- Dragging circuit parts from the Toolbox
- Right-clicking connecting lines and selecting Insert Circuit Part from the menu
- Selecting connecting lines and then selecting circuit parts from Insert – Circuit Parts in the Main Menu

1. Add an input.
   Enter variable SwYellow as an N.O. input.

   - Click the connecting line for rung 0.
   - Press the C Key to insert an input.
   - Enter sw.
   - Press the Down Arrow Key twice to select SwYellow BOOL, and then press the Enter Key twice to confirm.

   Useful Function
   A list of variables starting with sw are displayed automatically.
Additional Information

When you enter a rung object, the format is always checked and any mistakes are displayed as errors. If there are any errors, a red line is displayed between the rung number and the left bus bar.

Place the mouse over the red line to view information on the rung error.

2 Add a program input in an OR structure.

Connect the holdon variable with an OR connection.

Click the SwYellow variable input.

Press the W Key.

Enter holdon, and then press the Enter Key twice to confirm.

When the holdon variable is inserted into the Ladder Editor, the holdon variable is automatically added to the local variable table for Program0.
3 Add a program input in an AND structure.
Connect the *SwRed* variable as an N.C. input with an AND connection.

- Click the connecting line where you want to insert the AND instruction.

- Press the **C** Key.

- Enter *swred*, and then press the **Enter** Key twice to confirm.

- Click the input for the *SwRed* variable and press the **/** Key.

- The N.O. input is changed to an N.C. input.

4 Add an output.
Connect the *LmpYellow* variable and *holdon* variable as outputs.

- Click the connecting line where you want to insert the output.

- Press the **O** Key to insert an output.

- Enter *LmpYellow*, and then press the **Enter** Key twice to confirm.
Click the LmpYellow output and press the O key to insert an output.

Enter holdon, and then press the Enter Key twice to confirm.

5 Enter a rung comment.
   Enter a comment for Rung0.

Click Enter Rung Comment.

Enter Control for yellow indicator (self-holding rung) and press the Enter Key twice to confirm.

This concludes the creation of the algorithm for controlling the yellow indicator.
Additional Information

You can also insert ladder rungs without using the shortcut keys, as shown below.

- Method 1: Drag a circuit part from Ladder Tools in the Toolbox.

- Method 2: Right-click a connecting line and select the circuit part from the menu to insert it.

- Method 3: Click a connecting line and then select a circuit part from Insert – Circuit Parts in the Main Menu.

Creating the Algorithm for Controlling the Green Indicator (ON-delay Timer)

Create the algorithm.

- When the green pushbutton switch is turned ON, the green indicator lights 3 seconds later.
- When the green pushbutton switch is turned ON and then turned OFF again within 3 seconds, the green indicator does not light.
- When the green pushbutton switch is turned OFF while the green indicator is lit, the green indicator goes out.
To create a delay from the time the green pushbutton switch is pressed until the green indicator lights, use the On-Delay Timer instruction (TON).

The On-Delay Timer instruction (TON) operates as shown in the following figure.

The On-Delay Timer instruction (TON) contains the following variables.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Item</th>
<th>I/O</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>In</td>
<td>Timer input</td>
<td>Inputs</td>
<td>TRUE: Timer start signal</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FALSE: Timer reset signal</td>
</tr>
<tr>
<td>PT</td>
<td>Set time</td>
<td></td>
<td>Time from when timer starts until Q changes to TRUE</td>
</tr>
<tr>
<td>Q</td>
<td>Timer output</td>
<td>Outputs</td>
<td>TRUE: Timer output ON</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FALSE: Timer output OFF</td>
</tr>
<tr>
<td>ET</td>
<td>Elapsed time</td>
<td></td>
<td>Elapsed time since timer started</td>
</tr>
</tbody>
</table>

**Additional Information**

NJ-series CPU Units support the following five timer instructions.

You can select instructions according to the applications to increase the readability of your programs as well as programming productivity.

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Name</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>TON</td>
<td>On-Delay Timer</td>
<td>The TON instruction outputs TRUE when the set time elapses after the timer starts.</td>
</tr>
<tr>
<td>TOF</td>
<td>Off-Delay Timer</td>
<td>The TOF instruction outputs FALSE when the set time elapses after the timer starts.</td>
</tr>
<tr>
<td>TP</td>
<td>Timer Pulse</td>
<td>The TP instruction outputs TRUE while the set time elapses after the timer starts.</td>
</tr>
<tr>
<td>AccumulationTimer</td>
<td>Accumulation Timer</td>
<td>The AccumulationTimer instruction totals the time that the timer input is TRUE.</td>
</tr>
<tr>
<td>Timer</td>
<td>Hundred-ms Timer</td>
<td>The Timer instruction outputs TRUE when the set time elapses after the timer starts. Set the time in increments of 100 ms. The timing accuracy is 100 ms. Use this instruction to shorten instruction execution time.</td>
</tr>
</tbody>
</table>
1. Insert a rung.

Click rung 0.

Press the **R** Key.
Or, right-click and select *Insert Rung Below* from the menu.*

A rung is inserted below the selected rung.

* To insert above the selected rung, click the rung, and then hold down the **Shift** Key and press the **R** Key. Or, right-click and select *Insert Rung Above* from the menu.

2. Insert the FB instruction.

   Insert the On-Delay Timer instruction.

   Add the N.O. input for the *SwGreen* variable.

   Click the connecting line at the location where you want to insert the instruction.

   Press the **F** Key.*

   An FB with no function block definition name is inserted.
Enter ton.

**Press the I Key to insert a function.**

3 Enter the instance name of the FB instruction.

Enter the instance name of the inserted On-Delay Timer instruction. Enter TON_instance for the instance name.

**Click the TON instruction.**

**Press the Enter Key twice to confirm.**

Or, right-click and select **Enter Instance Variable Name** from the menu.

This allows you to enter an instance name.

**Enter TON_instance, and then press the Enter Key to confirm.**

After the instance name is entered, TON_instance is automatically added to the local variable table of Program0.
Enter the parameters.

Enter the parameters for the On-Delay Timer instruction.

Enter the input parameter for input variable *PT*. We want the indicator to light after three seconds, so enter \( T \#3s \) here.

This concludes entering the input parameter for input variable *PT*.

For this algorithm, the elapsed time from the start of the timer is not required, so no entries are needed for output variable *ET* (elapsed time).

Connect the *LmpGreen* output to the right of output variable *Q* to complete entering the parameter for the On-Delay Timer instruction.

Enter a rung comment to complete the algorithm for controlling the green indicator.

**Additional Information**

Refer to *A-3 Frequently Used Programming Operations* for the procedure to add differential type inputs, always TRUE inputs, and other common tasks.
4-4 Creating the EtherCAT Network Configuration

Register the Digital I/O Slave Units (GX-ID1611 and GX-OD1611) in the EtherCAT network configuration.

1. Double-click EtherCAT under Configurations and Setup in the Multiview Explorer. Or, right-click EtherCAT under Configurations and Setup and select Edit from the menu.

2. Drag GX-ID1611 Rev:1.1 from the Toolbox to the master on the EtherCAT Tab Page. Or, select the master on the EtherCAT Tab Page, and then double-click GX-ID1611 Rev:1.1 in the Toolbox.

The GX-ID1611 is added under the master.

3. In the same way, drag GX-OD1611 Rev:1.1 from the Toolbox to the GX-ID1611 on the EtherCAT Tab Page. Or, select the GX-ID1611 on the EtherCAT Tab Page, and then double-click GX-OD1611 Rev:1.1 in the Toolbox.

This concludes the creation of the network configuration.

Useful Function
You can restrict the Slave Units that are displayed by specifying groups.

Useful Function
You can restrict the Slave Units that are displayed by entering keywords.
Additional Information

If the physical EtherCAT network configuration is already connected, you can automatically create the virtual network configuration in the Sysmac Studio based on the physical network configuration. For details, refer to A-4 Creating an Online Network Configuration (page A-15).
Variables that are used to access data in devices such as EtherCAT slaves and CJ-series Units are called device variables.

In this section, we will set the global variables we defined to access the pushbutton switches and indicators to device variables for the Digital I/O Slave Units. These settings create the connections between the I/O information of the Digital I/O Slave Units and the program.

<table>
<thead>
<tr>
<th>Slave location</th>
<th>Slave name</th>
<th>I/O port</th>
<th>Description</th>
<th>Global variables set for the device variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node 1</td>
<td>GX-ID1611</td>
<td>In Bit00</td>
<td>Input bit 00</td>
<td>SwYellow</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In Bit01</td>
<td>Input bit 01</td>
<td>SwRed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In Bit02</td>
<td>Input bit 02</td>
<td>SwGreen</td>
</tr>
<tr>
<td>Node 2</td>
<td>GX-OD1611</td>
<td>Out Bit00</td>
<td>Output bit 00</td>
<td>LmpYellow</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Out Bit01</td>
<td>Output bit 01</td>
<td>LmpGreen</td>
</tr>
</tbody>
</table>

Device variables are set on the I/O Map.

1. Double-click **Axis Settings** under **Configurations and Setup – I/O Map** in the Multiview Explorer. Or, right-click **I/O Map** under **Configurations and Setup** and select **Edit** from the menu.

2. Double-click the box in the Variable Column for **In Bit00** under **Node1, GX-ID1611** on the I/O Map, and select the SwYellow global variable.

3. Set the other global variables to device variables in the same way.

This concludes the setting of device variables for Digital I/O Slave Units.
4-6 Debugging the Program

Online debugging is the process of placing the Sysmac Studio online with a CPU Unit to check its operation. Offline debugging is the process of checking the operation of a CPU Unit with the Simulator in the Sysmac Studio on a computer, without going online with the CPU Unit. Use offline debugging if you do not have an physical CPU Unit to use for testing.

The actual debugging operations in this Guide are the same for both online and offline debugging, but require different steps for preparation.

Additional Information

- There are some differences in debugging between online and offline debugging. For details, refer to A-5 Differences between Online and Offline Debugging (page A-17).
- You must build programs whenever you create or change them. Building is the process of converting your project programs into a format that is executable on the CPU Unit. The Sysmac Studio will automatically build the programs when you change them. Therefore, the procedure to build the programs is omitted from this Guide. If you perform no operations for five seconds after you change data types, global variables, or the local variables or the algorithm of a program, building the programs is started automatically.

4-6-1 Preparations for Online Debugging

To prepare for online debugging, you must check the program and then transfer the project to the CPU Unit.

- Perform a Program Check
  1. Check all programs.

```plaintext
Select Check All Programs from the Project Menu.
```

The results of the program check are displayed in the Build Tab Page. If there are any errors, correct them.
● Going Online

1. Turn ON the power supply to the Controller.
2. If Digital I/O Slave Units are connected, turn ON the power supply to the Digital I/O Slave Units.
3. Use one of the following methods to go online.

Method 1: Select **Online** from the Controller Menu.

Method 2: Click the Button on the toolbar.

Method 3: Press the Ctrl Key + the W Key.

4. The following message is displayed if no CPU Unit name is set for the Controller. Click the Yes Button.

The Sysmac Studio goes online.
### Transferring the Project

You must transfer the project to the CPU Unit. The synchronize operation is used to transfer the project.

Here, “synchronize” means to automatically compare the data for the Sysmac Studio on the computer with the data in the physical Controller and transfer the data in the direction that is specified by the user.

1. Use one of the following methods to display the Synchronize Pane.

   - **Method 1:** Select *Synchronization* from the Controller Menu.
   - **Method 2:** Click the ![Synchronize button](image)
   - **Method 3:** Press the `Ctrl` Key + the `M` Key.

Comparison of the data on the computer and the data in the physical Controller is started. The comparison results are displayed after the comparison is completed.
2 Click the **Transfer to Controller** Button.

The operating mode changes to **PROGRAM mode**, and the Sysmac Studio starts transferring the project to the CPU Unit. During the transfer, a progress bar appears in the Synchronize Pane.

3 Click the **Yes** Button.

The following dialog box is displayed when the transfer is completed. Click the **Yes** Button.

The operating mode changes back to **RUN mode**.
5 Click the Close Button in the lower right corner of the Synchronize Pane.

The Synchronize Pane closes.

**Precautions for Correct Use**

The Sysmac Studio will automatically build the programs if you change data types, global variables, or the local variables or the algorithm of a program. You cannot transfer the project to the CPU Unit during execution of the build operation. Transfer the project after the build operation is completed. The progress of building the programs is displayed in a progress bar at the lower right of the window.

● Checking for Controller Errors

1 Open the Detailed View of the Controller Status Pane.

The Detailed View of the Controller Status Pane is displayed.
2 If a Controller error has occurred, open the Troubleshooting Window.

Select Troubleshooting from the Tools Menu.
Or, click the button on the toolbar.

The Troubleshooting Window is displayed.

3 Refer to the error details and troubleshooting information to solve the problems and eliminate all errors.

4 Click the Reset All Button to clear all errors.

All errors are reset.
If the cause of the error is not removed, the error will occur again.

Precautions for Correct Use

- If an EtherCAT communications cable is not properly connected or if power is not supplied to a Digital I/O Slave Unit, a minor fault level Controller error (a Link OFF Error or Network Configuration Verification Error) will occur. If you are sure that all EtherCAT communications cables are properly connected, first check to make sure that power is being supplied to the Digital I/O Slave Units before you reset the errors.
- If a major fault level Controller error has occurred, you must cycle the power to the Controller.
4-6-2 Preparations for Offline Debugging

To prepare for offline debugging, you must check the program and then start the Simulator.

- **Performing a Program Check**
  1. Check all programs.

  Select **Check All Programs** from the Project Menu.

  The results of the program check are displayed in the Build Tab Page. If there are any errors, correct them.

- **Starting the Simulator**
  1. Use one of the following methods to display the Simulation Pane.

    **Method 1:** Select **Simulation Pane** from the View Menu.

    **Method 2:** Press the **Alt** Key + the **8** Key.

    The Simulation Pane is displayed.
2 Use one of the following methods to start the Simulator.

**Method 1:** Select *Run* from the Simulation Menu.

**Method 2:** Click the Button in the Simulation Pane.

**Method 3:** Press the F5 Key.

When the Simulator has started, the Controller Status Pane appears as shown in the following figure.

This concludes the procedure for starting Simulator.

**Precautions for Correct Use**

The Sysmac Studio will automatically build the programs if you change data types, global variables, or the local variables or the algorithm of a program. You cannot start the Simulator while the build operation is in progress. Start the Simulator after the build operation is completed. The progress of building the programs is displayed in a progress bar at the lower right of the window.
### Additional Information

- The Simulator operates slower than the operation in the CPU Unit. Therefore, in the Simulator, the time from the execution of a timer instruction until the set time expires is slower than the time required on the CPU Unit.
- Use one of the following methods to stop simulation.

#### Method 1: Select *Stop* from the Simulation Menu.

#### Method 2: Click the Button in the Simulation Pane.

#### Method 3: Press the **Shift** Key + the **F5** Key.
4-6-3 Debugging Program Logic

Next we will perform debugging to verify that the logic in our program operates as intended. This section describes how to debug program logic using the algorithm that controls the yellow indicator as an example.

Use the functions listed in the following table to debug the logic. If you perform online debugging with a system configuration that uses Digital I/O Slave Units, you can use forced refreshing to change an input value. If you perform offline debugging or if the system configuration does not use Digital I/O Slave Units, you can use the Set/Reset Menu to change an input value.

<table>
<thead>
<tr>
<th>Function name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring</td>
<td>You can monitor the TRUE/FALSE status of program inputs and outputs and the present values of variables in the Controller. You can control BOOL variables in the Ladder Editor, ST Editor, Watch Tab Pages, or I/O Map. For this example, we will use monitoring in the Ladder Editor and on the Watch Tab Page.</td>
</tr>
<tr>
<td>Forced refreshing</td>
<td>Forced refreshing allows you to refresh external inputs and outputs with user-specified values from the Sysmac Studio to debug the system. If you perform online debugging with a system configuration that uses Digital I/O Slave Units, you can use forced refreshing to change the input value from a push-button switch.</td>
</tr>
<tr>
<td>Controller BOOL variables (Set/Reset)</td>
<td>You can change the value of any BOOL variable to TRUE or FALSE. If you perform offline debugging or if the system configuration does not use Digital I/O Slave Units, you can use the Set/Reset Menu to change the input value from a pushbutton switch.</td>
</tr>
</tbody>
</table>

Additional Information

- Inputs from Input Slave Units that are not connected to switches or other input devices are always OFF. Therefore, use forced refreshing to check operation. The Set/Reset Menu cannot be used to change the values of variables. When you perform online debugging and EtherCAT slaves or CJ-series Units are actually connected, use forced refreshing to check operation.
- When a device variable is set in the I/O Map, use forced refreshing to check operation with the Simulator. However, operations from the Simulator cannot overwrite the values of variables from switches or other actual inputs. Therefore, use the Set/Reset Menu to check operation.
Monitoring

This section describes how to monitor program execution in the Ladder Editor and on the Watch Tab Page.

- Monitoring on the Ladder Editor

If the Ladder Editor is displayed when the Sysmac Studio is online with the Controller or when the Simulator is running, the rungs in the Ladder Editor are displayed in the monitored state. In monitored state, you can check the TRUE/FALSE status of inputs and outputs, the TRUE/FALSE status of the circuits, the forced status, the present values of variables set for parameters, and other status.

- Monitoring on a Watch Tab Page

You can check the present value of one or more variables on the Watch Tab Page.

You use the following procedure to register a variable to the Watch Tab Page. The SwYellow variable is used as an example.

1. Use one of the following methods to display the Watch Tab Page.

   Method 1: Select Watch Tab Page from the View Menu.

   Method 2: Click the Button.
The Watch Tab Page is displayed at the bottom of the Sysmac Studio Window.

2 Use one of the following methods to register a variable on the Watch Tab Page.

Method 1: Input the variable name.

Click **Input Name**.

Enter **Sw**.

Press the **Down Arrow Key** twice to select **SwYellow**, and then press the **Enter** Key to confirm.

The **SwYellow** variable is registered on the Watch Tab Page.
The following table lists input examples for registering other variables.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Input example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable: LmpYellow</td>
<td>Global variable</td>
<td>LmpYellow</td>
</tr>
<tr>
<td>Variable: holdon</td>
<td>Program0 local variable</td>
<td>Program0.holdon</td>
</tr>
<tr>
<td>Variable Q</td>
<td>The output variable for the TON_instance local variable in Program0.</td>
<td>Program0.TON_instance.Q</td>
</tr>
</tbody>
</table>

Method 2: Drag and drop.

Click the input for the SwYellow variable in the Ladder Editor.

Drag the variable onto **input Name**.

The SwYellow variable is registered on the Watch Tab Page.

**Additional Information**

You can register a program name (or instance name for a function block) to register all the local variables for that program in a hierarchy.
**Forced Refreshing**

If you perform online debugging with a system configuration that uses Digital I/O Slave Units, you can use forced refreshing to change the input value from a pushbutton switch to debug the program.

- **Forcing the Input Value of the Yellow Pushbutton Switch to TRUE**

  Use the following procedure to perform forced refreshing in the Ladder Editor.

  1. Select `SwYellow`, the device variable for the yellow pushbutton switch.

  ![Click the input for the SwYellow variable in the Ladder Editor.](image)

  2. Use one of the following methods to force the input value of the yellow pushbutton switch to TRUE.

     **Method 1:** Select **Forced Refreshing – TRUE** from the Controller Menu.

     ![Method 1](image)

     **Method 2:** Right-click and select **Forced Refreshing – TRUE** from the menu.

     ![Method 2](image)

     **Method 3:** Press the `Ctrl` Key + the `J` Key.*

     ![Method 3](image)

     *Press the `Ctrl` Key + the `K` Key to force the input to FALSE.

   The input value from the yellow pushbutton switch is forced to TRUE, and the yellow indicator lights. The self-holding rung also activates at this time.
Canceling the Forced Status for the Input Value of the Yellow Pushbutton Switch

Use the following procedure to cancel forced status in the Ladder Editor.

1. Select SwYellow, the device variable for the yellow pushbutton switch.

2. Use one of the following methods to release the forced input value of the yellow pushbutton switch.

   **Method 1:** Select *Forced Refreshing – Cancel* from the Controller Menu.

   ![Controller Menu with Forced Refreshing option selected](image)

   - Click the input for the `SwYellow` variable in the Ladder Editor.

   - Method 1: Select *Forced Refreshing – Cancel* from the Controller Menu.

   - Method 2: Right-click and select *Forced Refreshing – Cancel* from the menu.

   ![Ladder Editor with Forced Refreshing option highlighted](image)

   - Method 3: Press the `Ctrl` Key + the `L` Key.

   - The yellow pushbutton switch is forced to TRUE.
   - The yellow indicator lights.
   - The self-holding rung activates.
The input value changes back to FALSE when the forced status for the input value of the yellow pushbutton switch is released. In the configuration described in this Guide, the pushbutton switch is not wired and therefore the input is always FALSE. Because the self-holding rung is activated, the yellow indicator will stay lit.

**Forcing the Input Value of the Red Pushbutton Switch to TRUE**

You perform forced refreshing on a Watch Tab Page. First, register the \textit{SwRed} variable on the Watch Tab Page.

1. Select \textit{SwRed}, the device variable for the red pushbutton switch.

2. Force the input from the red pushbutton switch to TRUE.

When the input value from the red pushbutton switch is forced to TRUE, the self-holding rung is reset and the yellow indicator goes out.
● Canceling the Forced Status for the Input Value of the Red Pushbutton Switch

Use the following procedure to cancel forced status on a Watch Tab Page

1. Cancel the forced status for the input value of the red pushbutton.

Right-click and select **Forced Refreshing Cancel** from the menu.

Additional Information

- You can perform forced refreshing in the above Ladder Editor, or on Watch Tab Page or on the I/O Map. On the I/O Map, you can perform forced refreshing without defining variables or creating an algorithm. Forced refreshing on the I/O Map is therefore convenient to check the I/O wiring of EtherCAT slaves or CJ-series Units. Refer to **A-6 Forced Refreshing on the I/O Map** for the procedure.
- Select **Forced Refreshing – Cancel All** from the Controller Menu to cancel all of the forced status.

Controller BOOL Variables (Set/Reset)

If you perform offline debugging or if the system configuration does not use Digital I/O Slave Units, you can use the Set/Reset Menu to change the input value from a pushbutton switch.

● Setting/Resetting the Input Value of the Yellow Pushbutton Switch

Use the following procedure to set or reset variables in the Ladder Editor.

1. Select **SwYellow**, the device variable for the yellow pushbutton switch.

2. Use one of the following methods to reset or set the input from the yellow pushbutton switch.

   Method 1: Select **Set/Reset – Set or Reset** from the Controller Menu.
When the input from the yellow pushbutton switch is set, the $LmpYellow$ variable changes to TRUE. Then, even if the input from the yellow pushbutton switch is reset, the $LmpYellow$ variable remains TRUE due to the operation of the self-holding rung.

### Setting/Resetting the Variable for the Red Pushbutton Switch

Use the following procedure to set or reset variables in the Watch Tab Page. First, register the $SwRed$ variable on the Watch Tab Page.

1. Select *SwRed*, the device variable for the red pushbutton switch.

---

| Method 2: | Right-click and select **Set/Reset**  - **Set** or **Reset** from the menu. |

---

| Method 3: | **Set**: Press the $\text{Ctrl}$ Key + the $\text{Shift}$ Key + the $J$ Key. |
| **Reset**: Press the $\text{Ctrl}$ Key + the $\text{Shift}$ Key + the $K$ Key. |

---

When the input from the yellow pushbutton switch is set, the $LmpYellow$ variable changes to TRUE. Then, even if the input from the yellow pushbutton switch is reset, the $LmpYellow$ variable remains TRUE due to the operation of the self-holding rung.
2 Select TRUE in the Modify Column to change the variable to TRUE. Select FALSE in the Modify Column to change the variable to FALSE.

<table>
<thead>
<tr>
<th>Name</th>
<th>Online value</th>
<th>Modify</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>SwYellow</td>
<td>False</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
<tr>
<td>SwRed</td>
<td>False</td>
<td>TRUE</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

If the input from the red pushbutton switch is set while the self-holding rung is in operation, the self-holding rung is reset and the *LmpYellow* variable changes to FALSE.

### 4-6-4 Using a Data Trace to Confirm the Operation of the Indicators

Use a data trace to check the ON-delay timer operation of the green indicator. The procedure is the same for both online and offline debugging.

#### Setting Up the Data Trace

Start the data trace, and then set the trace type, trigger condition, and variable to sample.

- **Starting the Data Trace**

  1. Create the data trace settings.

Right-click *Data Trace Settings* under **Configurations and Setup** in the Multiview Explorer and select *Add – Data Trace* from the menu.

*DataTrace0* is added to the Multiview Explorer.
2 Double-click **DataTrace0**.
The Data Trace Tab Page is displayed.

### Setting the Trace Type and Trigger Condition
You must set the Trace Type and Trigger Condition. Set the trace type and trigger condition as shown below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Set value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trace type</td>
<td>Single Trace</td>
<td>This trace type samples the data before and after the trigger condition is met. A total of 10,000 samples are taken per variable. For this example, we want to sample the data before and after the trigger condition is met. Therefore, set the trace type to Single.</td>
</tr>
<tr>
<td>Sampling interval</td>
<td>Specified task period of primary task</td>
<td>These setting is used to sample the value once every primary periodic task. For this example, the task period of the primary periodic task is set to 1 ms. Therefore, 10 seconds worth of data can be sampled. (1 ms × 10,000 samples)</td>
</tr>
<tr>
<td>Post-trigger data ratio</td>
<td>90%</td>
<td>A value of 90% means that 10% of the sampling data is from before the trigger condition is met and 90% of the sampling data is from after the trigger condition is met.</td>
</tr>
<tr>
<td>Trigger condition</td>
<td>Selected, when variable SwGreen changes to TRUE</td>
<td>This sets the trigger condition to when the SwGreen variable changes to TRUE.</td>
</tr>
</tbody>
</table>
The procedure for setting the trace type and trigger condition is given below.

1. Select *Single* from the *Trace Type* Box.

   ![Trace type Single](image)

2. Select *Every period of task* and *Primary Task* from the *Sampling interval* Boxes.

   ![Sampling interval Every period of task Primary Task](image)

3. Use one of the following methods to set the post-trigger data ratio to 90%.

   **Method 1:** Drag the Post-trigger Data Ratio Slider to 90%.

   ![Post-trigger data ratio slider](image)

   **Method 2:** Enter 90 directly into the Post-trigger Data Ratio Text Box.

   ![Post-trigger data ratio text box](image)

4. Enable the trigger condition, and set the trigger condition to when the *SwGreen* variable changes to TRUE.

   Select the *Enable Trigger Condition* Check Box.

   ![Enable trigger condition](image)

   Enter *SwGreen* in the text box.

   ![SwGreen text box](image)

   Click the box and select *TRUE (rising)*.

**Setting the Variables to Trace**

You must set the variable to trace.

For this example, the *SwGreen* and *LmpGreen* variables are set as the variables to trace.

1. Add a trace variable line to the list.

   ![Trace variable list](image)
2 Add the SwGreen variable.

Add the SwGreen variable.

3 Add the LmpGreen variable in the same way.

Performing a Data Trace

Start the data trace and check the results.

First, register the SwGreen and LmpGreen variables on the Watch Tab Page.

1 Click the Start Trace Button.

When the data trace is started, the toolbar on the Data Trace Tab Page is displayed as follows:

2 Change the device variable for the green pushbutton switch, SwGreen, to TRUE in the Watch Tab Page.

If you perform online debugging with a system configuration that uses Digital I/O Slave Units, use forced refreshing to change the variable to TRUE. If you perform offline debugging or if the system configuration does not use Digital I/O Slave Units, use the Set/Reset Menu to change the variable to TRUE.

When the trigger condition is met and the number of samples reaches 10,000, the results of the data trace are displayed.
4-43

4-6 Debugging the Program

4-6-5 Modifying the Logic with Online Editing

Online editing allows you to change or add parts of the user program within the CPU Unit directly from the Sysmac Studio.

You can select any of the following to perform online editing.

- Ladder section
- POU (program, function, or function block) written in ST
- Global variables

For this example, we will change the set time for the On-delay Timer instruction used to control the green lamp from 3 seconds to 5 seconds. The procedure is the same for both online and offline debugging.

1. Open Section0 of Program0.

Additional Information

You can use the various tool buttons on the Data Trace Tab Page to show or hide certain information.

For the above figure, perform the following settings:

- Hide: Grid, Cursor, Trace Settings, Analog Chart
- Show: Legend

Displaying Data Trace Results

The results are displayed on the Data Trace Tab Page as shown in the following figure.

A trigger occurs when the SwGreen variable changes to TRUE.

Three seconds later, the green lamp lights.
2 Use one of the following methods to start online editing.

Method 1: Select **Online Edit – Start** from the Project Menu.

Method 2: Press the Ctrl Key + the E Key.

3 In the Ladder Editor, change the parameter for the On-Delay timer instruction input variable \( PT \) to \( T\#5s \).

4 Use one of the following methods to transfer the changes made.

Method 1: Select **Online Edit – Transfer** from the Project Menu.

Method 2: Press the Ctrl Key + the Shift Key + the E Key.

5 A confirmation dialog box is displayed. Click the Yes Button.

Click the Yes Button.

The logic in the user program in the CPU Unit is changed.
This concludes the process for online editing.

![Diagram of Control for green indicator (on-delay timer)](image)
4 Programming and Debugging
This section describes various useful functions that you can use with a NJ-series CPU Unit or the Sysmac Studio.

5-1 Registering and Managing Application Events ........................................ 5-2
5-2 Protecting User Program Assets ............................................................... 5-5
  5-2-1 Preventing Theft with Authentication of User Program Execution IDs ........................................ 5-5
  5-2-2 Preventing Theft By Transferring without User Program Restoration Information ........................................ 5-6
  5-2-3 Protecting User Asset Information with Overall Project File Protection ........................................ 5-6
  5-2-4 Using Data Protection to Protect User Asset Information ........................................ 5-6
  5-2-5 Preventing Incorrect Operation with Operation Authority Verification ........................................ 5-7
  5-2-6 Preventing Write Operations from the Sysmac Studio with Write Protection ........................................ 5-9
  5-2-7 Using CPU Unit Names to Prevent Incorrect Connections from the Sysmac Studio ........................................ 5-9
5-1 Registering and Managing Application Events

You can register and manage custom events as user-defined events. User-defined events are registered in the Event Setting Table of the Sysmac Studio, and are triggered by instructions for user-defined events. Triggered user-defined events can be viewed in the Sysmac Studio or on an NS-series PT that is compatible with the NJ-series Controllers.

Characteristics of User-defined Events

User-defined events have the following characteristics:

- They can be divided up by event level (8 levels of user-defined errors and user-defined information) based on their purpose.
- You can specify a group name to represent the location or type of the event.
- They can be logged and managed along with Controller event errors and information defined in the NJ-series Controllers.
- You can view these event logs on a timeline from the Sysmac Studio or from an NS-series PT that is compatible with NJ-series Controllers.
### Using the User-defined Event Log

The procedures for setting user-defined events and viewing them are given below.

#### Setting User-defined Events

1. **Double-click Event Settings** under **Configurations and Setup** in the Multiview Explorer.

2. **Register the user-defined events in the Event Settings Table.**

<table>
<thead>
<tr>
<th>Event Code</th>
<th>Event Name</th>
<th>Level</th>
<th>Group</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Emergency stop</td>
<td>User fault level 1</td>
<td>Linear interpolation is stopped by emergency stop switch.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>40001</td>
<td>Operation start</td>
<td>User information</td>
<td>Linear interpolation starts by operation start switch.</td>
</tr>
<tr>
<td>3</td>
<td>40002</td>
<td>Operation completed</td>
<td>User information</td>
<td>Linear interpolation is completed.</td>
</tr>
</tbody>
</table>

#### Additional Information

You can edit the contents of the Event Settings Table with Microsoft Excel. Refer to the **Sysmac Studio Version 1 Operation Manual** (Cat. No. W504) for details.

<table>
<thead>
<tr>
<th>Event Code</th>
<th>Event Name</th>
<th>Level</th>
<th>Group</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Emergency stop</td>
<td>User fault level 1</td>
<td>Linear interpolation is stopped by emergency stop switch.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>40001</td>
<td>Operation start</td>
<td>User information</td>
<td>Linear interpolation starts by operation start switch.</td>
</tr>
<tr>
<td>3</td>
<td>40002</td>
<td>Operation completed</td>
<td>User information</td>
<td>Linear interpolation is completed.</td>
</tr>
</tbody>
</table>

#### Program the Create User-defined Information or Create User-defined Error instruction.

**User-defined errors:** Use the Create User-defined Error (SetAlarm) instruction.

**User-defined information:** Use the Create User-defined Information (SetInfo) instruction.

---

** Registering the Start of Linear Interpolation as a User-defined Event**

![Linear interpolation start event register](image1)

** Registering the End of Linear Interpolation as a User-defined Event**

![Linear interpolation end event register](image2)
**Precautions for Correct Use**

You must specify variables for *Info1* (Attached Information 1) and *Info2* (Attached Information 2) in the Create User-defined Error (SetAlarm) and Create User-defined Information (SetInfo) instructions. If you use a constant, a building error will occur. If you do not use the attached information, specify a dummy variable.

4 Transfer the Event Setting Table and user program to the CPU Unit.

- **Checking for User-defined Events**

1 Select **Troubleshooting** from the Tools Menu while online. Or, click the **Troubleshooting** Button in the toolbar.

You can view the status of user-defined events on the User-defined Errors and User-defined Event Log Tab Pages.
5-2 Protecting User Program Assets

The security functions are used to protect user program assets. The following table lists the security functions. This section provides an overview of these security functions.

<table>
<thead>
<tr>
<th>Security measure</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication of user program execution IDs</td>
<td>Prevention of the theft of assets</td>
</tr>
<tr>
<td>User program transfers with no restoration information</td>
<td></td>
</tr>
<tr>
<td>Overall project file protection</td>
<td></td>
</tr>
<tr>
<td>Data protection*1</td>
<td></td>
</tr>
<tr>
<td>Operation authority verification</td>
<td>Prevention of incorrect operation</td>
</tr>
<tr>
<td>Write protection</td>
<td></td>
</tr>
<tr>
<td>CPU Unit names</td>
<td>Prevention of incorrect connections</td>
</tr>
</tbody>
</table>

*1. A CPU Unit with unit version 1.01 or later and Sysmac Studio version 1.02 or higher are required.

Additional Information

Refer to the Sysmac Studio Version 1 Operation Manual (Cat. No. W504) and the NJ-series CPU Unit Software User's Manual (Cat. No. W501) for details on the security functions.

5-2-1 Preventing Theft with Authentication of User Program Execution IDs

You can register a unique ID in the Controller in advance so that only the user program associated with that ID can be executed. This ID is called a user program execution ID.

You can use user program execution IDs to apply the following usage restrictions:
- Allow the execution of only a specific user program in a Controller.
- Prevent the use of the user program in a different Controller.

![Diagram showing user program execution ID process]

User program execution ID is assigned to user program.

The CPU Unit can execute the user program only when these two IDs match.
Precautions for Correct Use

- A user program execution ID can be set only one time for a user program.
- Record the user program execution ID to ensure you do not lose it.
- We recommend that you backup the project file before you set the user program execution ID.

5-2-2 Preventing Theft By Transferring without User Program Restoration Information

Normally, when you transfer the user program from the Sysmac Studio to the CPU Unit, information is transferred to restore it back from the CPU Unit.

You can perform a transfer without the user program restoration information to prevent this restoration information from being transferred. This prevents the user program from being read from the CPU Unit.

This function is used to prevent theft of user program data when on-site maintenance of the user program is not required.

5-2-3 Protecting User Asset Information with Overall Project File Protection

You can apply a password to a project file when it is exported. This encrypts the project file and protects the user assets.

5-2-4 Using Data Protection to Protect User Asset Information

You can place protection on part of the data in a project file to protect your assets.
5-2-5 Preventing Incorrect Operation with Operation Authority Verification

Online operations are restricted by operation rights to prevent damage to equipment or injuries that may be caused by operating mistakes. You can register operation authority verification passwords in the CPU Unit in advance from the Sysmac Studio. When the Sysmac Studio goes online with the Controller and a password is entered, only the operations that match the operation authority category for that password are enabled.

The Administrator sets a password for each operation authority. Users are notified of the operation authority name and password according to their skills.

Types of Operation Authorities

You can use the following five operation authorities on the Sysmac Studio. They are given in descending order of authority.

<table>
<thead>
<tr>
<th>English name</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Required.</td>
</tr>
<tr>
<td>Designer*1</td>
<td>Optional*2</td>
</tr>
<tr>
<td>Maintainer*1</td>
<td>Whether a password is required is determined by the default operation authority that is set in the Setting of Operation Authority Dialog Box. The default operation authority is used when a password is not input.</td>
</tr>
<tr>
<td>Operator*1</td>
<td>Not required.</td>
</tr>
<tr>
<td>Observer*1</td>
<td>Not required.</td>
</tr>
</tbody>
</table>

*1 A CPU Unit with unit version 1.01 or later and Sysmac Studio version 1.02 or higher are required.

*2 Whether a password is required is determined by the default operation authority that is set in the Setting of Operation Authority Dialog Box. A password must be entered to perform operations that require an operation authority that is higher than the default operation authority. A password is not required to perform operations that require an operation authority that is equal to or lower than the default operation authority.

Example of Operation Authority for Online Operations

(OK: Operation possible, VR: Verification required for each operation, NP: Operation not possible)

<table>
<thead>
<tr>
<th>Status monitor (example)</th>
<th>Administrator</th>
<th>Designer</th>
<th>Maintainer</th>
<th>Operator</th>
<th>Observer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring errors for troubleshooting</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>I/O monitor operations (examples)</th>
<th>Administrator</th>
<th>Designer</th>
<th>Maintainer</th>
<th>Operator</th>
<th>Observer</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O monitor: Reading</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>NP</td>
</tr>
<tr>
<td>I/O monitor: Writing</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>VR</td>
<td>NP</td>
</tr>
<tr>
<td>Controlling BOOL variables</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>VR</td>
<td>NP</td>
</tr>
<tr>
<td>Forced refreshing</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>NP</td>
<td>NP</td>
</tr>
</tbody>
</table>
## Password Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid number of characters</td>
<td>8 to 32</td>
</tr>
<tr>
<td>Applicable characters</td>
<td>Single-byte alphanumeric characters (case sensitive)</td>
</tr>
</tbody>
</table>
5-2-6 Preventing Write Operations from the Sysmac Studio with Write Protection

Write protection is used to prevent write operations from the Sysmac Studio.

Use one of the following two methods to enable write protection.

- You can automatically have write protection set when the power supply to the Controller is turned ON.
- In the Sysmac Studio, go online and select **Security – Change Write Protect Switch** from the Controller Menu to toggle write protection.

5-2-7 Using CPU Unit Names to Prevent Incorrect Connections from the Sysmac Studio

When going online to a CPU Unit from the Sysmac Studio, the CPU Unit name in the project is compared to the name of the CPU Unit being connected to.

This helps prevent incorrect connections to the CPU Unit from the Sysmac Studio. It is particularly effective when you connect over an EtherNet/IP network.
Appendices

The appendices describe common operating procedures for programming and debugging.

A-1 Using Cross References ........................................... A-2
A-2 Useful Functions for Editing Variable Tables ............................ A-5
A-3 Frequently Used Programming Operations .............................. A-8
A-4 Creating an Online Network Configuration ............................. A-15
A-5 Differences between Online and Offline Debugging .................. A-17
A-6 Forced Refreshing on the I/O Map .................................. A-18
A-1 Using Cross References

You use cross references to display lists of the locations in a project where variables or I/O ports for EtherCAT slaves are used.

This appendix uses the project that was created in the startup procedures to show how to use cross references. The following procedure shows how to use cross references to see where the SwRed variable is used in the Ladder Editor. The SwRed variable is registered in the global variable table.

1. Open the global variable table.
2. Select Cross Reference Tab Page from the View Menu.

The Cross Reference Tab Page is displayed.
3 Click the `SwRed` variable in the global variable table.

The locations where the `SwRed` variable is used are displayed in the Cross Reference Tab Page. If the variable is set as a device variable, the I/O port for the variable is also displayed.

4 Click the line with the `SwRed` variable on the Cross Reference Tab Page.

The variable name and ports are displayed.

The variable for which cross references are listed is displayed.

The locations where the variable is used are displayed.

The objects in which variable is used are displayed.
The location where the $SwRed$ variable is used is displayed in the Ladder Editor and the object in which it is used is selected.

Additional Information

In addition to the global variable table, you can also select variables in the Ladder Editor or I/O Map to find cross references for them.
These functions are useful when you edit variable tables: intuitive keyboard shortcuts for editing, variable name input assistance, and data type input assistance.

### Intuitive Keyboard Shortcuts

You can intuitively use keyboard shortcuts to create new variables and edit existing variables quickly and easily.

- **Use the Arrow Keys** to move between cells.
  - Move to the cell to the top.
  - Move to the cell to the left.
  - Move to the cell to the right.
  - Move to the cell to the bottom.

- **Use the Enter Key** to move to the cell to the right.
  - Move variable name.
  - Enter data type.
  - Enter.

- **Use the Insert Key** to insert a variable and the **Delete Key** to delete a variable.

```
<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Initial Value</th>
<th>AT</th>
</tr>
</thead>
<tbody>
<tr>
<td>SwYellow</td>
<td>BOOL</td>
<td></td>
<td>ECAT:7/n</td>
</tr>
<tr>
<td>SwRed</td>
<td>BOOL</td>
<td></td>
<td>ECAT:7/n</td>
</tr>
<tr>
<td>SwGreen</td>
<td>BOOL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

```
<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
<th>Initial Value</th>
<th>AT</th>
</tr>
</thead>
<tbody>
<tr>
<td>SwYellow</td>
<td>BOOL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SwRed</td>
<td>BOOL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SwGreen</td>
<td>BOOL</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Variable is inserted.

```
<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SwYellow</td>
<td>BOOL</td>
</tr>
<tr>
<td>SwRed</td>
<td>BOOL</td>
</tr>
<tr>
<td>SwGreen</td>
<td>BOOL</td>
</tr>
</tbody>
</table>
```

Variable is deleted.
• Use the Ctrl + C Keys to copy a variable and Ctrl + V Keys to paste a variable.

Select the variables to copy.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SwYellow</td>
<td>BOOL</td>
</tr>
<tr>
<td>SwRed</td>
<td>BOOL</td>
</tr>
<tr>
<td>SwGreen</td>
<td>BOOL</td>
</tr>
</tbody>
</table>

Select where to paste.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SwYellow</td>
<td>BOOL</td>
</tr>
<tr>
<td>SwRed</td>
<td>BOOL</td>
</tr>
<tr>
<td>SwGreen</td>
<td>BOOL</td>
</tr>
</tbody>
</table>

• Variable Name Input Assistance

When a variable is created, a number is automatically added to the end of the variable name. This is useful when creating similar variables.

• Data Type Input Assistance

• When a variable is created, a variable with the same data type as the variable above it is automatically inserted.
• You can select a data type from the list.

You can select a data type from the list.

Enter a partial string to narrow down the list of candidates.
A-3  Frequently Used Programming Operations

This section describes some frequently used programming operations.

### Entering Differentiated Inputs

#### Upward Differentiation

Right-click the input and select Diff Up from the menu.

#### Downward Differentiation

Right-click the input and select Diff Down from the menu.

### Entering Upward Differentiation Options for FUN Instructions

Enter @ at the beginning of the instruction name.

Click the connecting line and press the I Key. A function is inserted, and you can enter the function name.

Enter @MOVE.
Entering a One-second Clock Pulse Input

Click the connecting line and press the I Key.

A function is inserted, and you can enter the function name.

Enter Get1sClk and press the Enter Key twice.

Then, add a program output.

The clock pulse period is 100 us, 1 ms, 10 ms, 20 ms, 100 ms, 1 s, or 1 min.

Entering an Always TRUE Input

Click the connecting line and press the C Key.

An input is inserted.

Enter P_On, and then press the Enter Key twice to confirm.

Entering the First RUN Period Flag

Click the connecting line and press the C Key.

An input is inserted.

Enter P_First_RunMode, and then press the Enter Key twice to confirm.
### Copying and Pasting Rungs

Select the rung to copy.*

Right-click and select **Copy** from the menu.

Press the **Ctrl** Key + the **C** Key.

Select the location where you want to paste the rung.

Right-click and select **Paste** from the menu.

Press the **Ctrl** Key + the **V** Key.

The copied rung is pasted below the selected rung.

* To select multiple rungs, press and hold the **Shift** Key while you select additional rungs.
### Adding Sections

Right-click the program you want to add a section to in the Multiview Explorer and select **Add - Section** from the menu.

![Multiview Explorer with Section option highlighted](image)

A new section is added.

### Copying and Pasting Sections

Select the section to copy in the Multiview Explorer.

![Multiview Explorer with Copy option highlighted](image)

Right-click and select **Copy** from the menu.

Press the Ctrl Key + the C Key.

Right-click the program where you want to paste the section in the Multiview Explorer, and select **Paste** from the menu.

Press the Ctrl Key + the V Key.

The section is pasted at the bottom of the selected program.
### Changing the Order of Sections

Sections are executed from top to bottom in the order that they are displayed in the Multiview Explorer. To change the order of execution, you must change the order of the sections.

This section gives the procedure for moving a section up in the order.

Select the section to move in the Multiview Explorer.

Right-click and select **Move Up** from the menu.

Or, drag the section to the location you want it.

The section moves up.

### Adding POUs

You use the following procedure to add an ST language POU.

Right-click **Programs** in the Multiview Explorer, and select **Add → Structured Text** from the menu.

An ST language POU is added to the programs.
### Assigning Programs to Tasks

To execute the new POU, it must be assigned to a task. Use the following procedure to assign `Program1` (the program that was added) to the primary periodic task.

1. **Displaying the Instructions Reference**

   - **Assigning Programs to Tasks**
     - Double-click **Task Settings** under **Configurations and Setup** in the Multiview Explorer.

     ![Task Settings](image1)

   - **Click the Button in the Edit Pane.**

     ![Task Settings](image2)

   - **Click the Button and select Program1 from the list.**

     ![Task Settings](image3)

2. **Referencing Detailed Instruction Information**

   - **Displaying the Instructions Reference**

     - Click the instruction, and then click the Button.

       ![Instruction Reference](image4)

     - The Instruction Reference is displayed.
• Displaying Detailed Information on Input and Output Variables of Instructions

Move the mouse cursor over any input or output variable of an FB or FUN instruction. Details are displayed on the Ladder Editor.
### A-4 Creating an Online Network Configuration

If the actual EtherCAT network configuration is already connected, you can automatically create the virtual network configuration in the Sysmac Studio based on the actual network configuration.

1. While online, right-click the master in the EtherCAT Tab Page and select **Compare and Merge with Actual Network Configuration**.

   ![Compare and Merge with Actual Network Configuration](image)

   The Compare and Merge with Actual Network Configuration Window is displayed.

2. Click the **Apply actual network configuration** Button in the Compare and Merge with Actual Network Configuration Window.

   ![Apply actual network configuration dialog](image)

   The following dialog box is displayed.

3. Click the **Apply** Button.
The actual network configuration is registered as the Sysmac Studio network configuration.
# A-5 Differences between Online and Offline Debugging

There are different debugging functions available during online and offline debugging. The following table lists the differences between online and offline debugging.

<table>
<thead>
<tr>
<th>Operation for debugging</th>
<th>Online debugging</th>
<th>Offline debugging</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Monitoring on a Watch Tab Page</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Monitoring in the I/O Map</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Differential monitoring(^1)</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Controlling BOOL variables (Set/Reset)</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Forced refreshing (TRUE/FALSE/Cancel)</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Changing present values of data</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Clearing memory (Memory All Clear)</td>
<td>Supported.</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Cross-reference pop-ups</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Online editing</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Monitoring Controller status</td>
<td>Supported.</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Monitoring task execution status</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Monitoring axis status (MC Monitor Table)</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Changing the operating mode</td>
<td>Supported.</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Resetting the Controller</td>
<td>Supported.</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Data tracing</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Setting triggers</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Setting variables to sample</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Starting and stopping tracing</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Displaying trace results</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Exporting trace results</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Creating 3D device models</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Displaying in a digital/analog chart</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Displaying 3D axis paths</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Monitoring task execution times</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Estimating execution processing times</td>
<td>Not supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Debugging with program simulations</td>
<td>Not supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Setting what to simulate</td>
<td>Not supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Changing the simulation speed</td>
<td>Not supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Setting breakpoints</td>
<td>Not supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Step execution</td>
<td>Not supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>Supported.</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Monitoring error information</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Displaying error logs</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Event Setting Table</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Monitoring user memory usage</td>
<td>Supported.</td>
<td>Supported.</td>
</tr>
<tr>
<td>Setting clock information</td>
<td>Supported.</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Releasing access rights</td>
<td>Supported.</td>
<td>Not supported.</td>
</tr>
</tbody>
</table>

\(^1\) A CPU Unit with unit version 1.03 or later and Sysmac Studio version 1.04 or higher are required to use differential monitoring.
A-6  Forced Refreshing on the I/O Map

On the I/O Map, you can perform forced refreshing without defining variables or creating an algorithm. Forced refreshing on the I/O Map is therefore convenient to check the I/O wiring of EtherCAT slaves or CJ-series Units. You use the following procedure to perform forced refreshing on the I/O Map.

Forced Refreshing Procedure

1. Go online with the Controller. Or, start the Simulator.
2. Double-click I/O Map under Configurations and Setup in the Multiview Explorer.

The I/O Map is displayed.

3. Select the I/O port or variable for forced refreshing on the I/O Map.

4. Right-click and select Forced Refreshing – TRUE or Forced Refreshing – FALSE from the menu.

If you select TRUE, the variable or I/O port changes to TRUE. If you select FALSE, the variable or I/O port changes to FALSE. TRUE or FALSE is displayed in the Value Column of the I/O port or variable. An icon also appears by the I/O port or variable that shows the forced status.
Right-click the I/O port or variable for which to cancel forced status and select **Forced Refreshing – Cancel** from the menu.

The forced value for the I/O port or variable is canceled and the forced status icon disappears. The TRUE/FALSE status of the I/O port or variable will change according to the user program or system configuration.
Terms and Conditions of Sale

1. Offer, Acceptance. These terms and conditions (these "Terms") are deemed part of the offer and acceptance of orders for products, purchases, and sales of products. Omron objects to any terms or conditions proposed in Buyer's purchase order or other documents which are inconsistent with, or in addition to, these Terms.

2. Prices; Payment Terms. All prices stated are current, subject to change without notice. Buyer pays freight and insurance to the extent there is no reservation to the contrary. Buyer reserves the right to increase or decrease the prices on any unshipped portions of outstanding orders. Payments for Products are due net 30 days unless otherwise stated in the invoice.

3. Discount. Cash discounts, if any, will apply only on the net amount of invoices sent to Buyer after deducting transportation charges, taxes and duties, and will be allowed only if (i) the invoice is paid according to Omron's payment terms and (ii) Buyer has no past due amounts.

4. Interest. Omron, at its option, may charge Buyer 1-1/2% interest per month or the maximum rate allowable by law, whichever is less, on any balance not paid within the stated terms.

5. Orders. Omron will accept no order less than $200 net billing.

6. Governmental Approvals. Buyer shall be responsible for, and shall bear all costs involved in, obtaining any government approvals required for the importation or sale of the Products.

7. Taxes. All taxes, duties and other governmental charges (other than general property and income taxes), including any interest or penalties thereon, imposed directly or indirectly on Omron or required to be collected directly or indirectly by Omron for the manufacture, production, sale, delivery, importation, transport, storage or use of the Products sold hereunder (including customs duties and sales, excise, use, turnover and license taxes) shall be charged to and remitted by Buyer to Omron.

8. Financial. If the financial position of Buyer at any time becomes unsatisfactory to Omron, Omron reserves the right to stop shipments or require satisfactory security. (a) Buyer will not assign or transfer the title to or the rights in any Products or any part thereof without Omron's prior written consent.

9. Force Majeure. Omron shall not be liable for any delay or failure in delivery resulting from strikes, lockouts, labor disputes, accidents to property and/or labor, civil commotions, national emergency, quotas, embargos of governmental bodies, or any cause beyond Omron's control. Any such circumstances may be claimed by Omron as a justification for cancellation of orders.

10. Force Majeure. Omron will provide applicable third party certification documents identifying the Product in the Buyer's application or use of the Product. At Buyer's request, Omron will check and is believed to be accurate; however, no responsibility is assumed by Omron for the accuracy of the certification documents. Omron will not be liable for the unsuitability or the results from the use of Products in combination with any electrical or electronic components, circuits, system assemblies or any other materials or substances or environments.

11. Shipping; Delivery. Unless otherwise expressly agreed in writing by Omron:
   a. Shipments shall be by a carrier selected by Omron; Omron will not drop ship without Omron's "breathing" of the order.
   b. Such carrier shall act as the agent of Buyer and delivery to such carrier shall constitute delivery to Buyer.
   c. All sales and shipments of Products shall be FOB shipping point (unless otherwise stated in writing by Omron), at which point title and risk of loss shall pass from Omron to Buyer; provided that Omron shall retain a security interest in the Products until the full purchase price is paid;
   d. Delivery and shipping dates are estimates only; and
   e. Omron will package Products as it deems proper for protection against normal handling and extra charges apply to special conditions.

12. Claims. Buyer's claim for any alleged damages or damage to the Products occurring before delivery to the carrier must be presented in writing to Omron within 10 days of receipt of the Products by the carrier and will be supported by an invoice and insurance receipt from the carrier. Claims must be accompanied by the shipping document and the invoice signed by the carrier and the note of damage or shortage noted thereon. Buyer will bear all reasonable and necessary charges for handling, inspecting and testing the Products and other costs of proof. No such claim by Buyer shall be asserted unless it is asserted in writing by Omron. Omron will make an investigation and if it concludes in its own opinion, that the Products were duly shipped to Buyer in good order and condition and in accordance with Buyer's specifications, Buyer will be responsible for the cost of such investigation and for any damage or shortage so found and no claim will be made by Buyer.

13. Indemnification. Buyer shall defend, indemnify and hold harmless Omron Companies and their employees from and against all claims, demands, losses, costs, damages, and expenses (including attorney's fees and expenses) related to any claim, investigation, litigation or proceeding (whether or not Omron is a party) which arises or is alleged to arise from (i) any Products in transit prior to their delivery to Buyer or (ii) claims made by Buyer or its agents or employees for any Products shipped to Buyer and will hold harmless Omron and its employees for any liabilities, losses, claims, damages, costs or expenses (including real property and income taxes), including any interest or penalties thereon, arising out of or connected with the sale, delivery, use or ownership of any Products.

14. Property; Confidentiality. Any intellectual property in the Products is the exclusive property of Omron and Buyer shall not use, disclose or permit the use, disclosure or reproduction of any such material or information to any other party or entity without the written permission of Omron. Upon demand, Buyer shall provide Omron with a complete and accurate accounting of all such material and information and the use made thereof. Buyer shall not own or retain any such material or information and Buyer shall not disclose such material or information to any third party.
Authorized Distributor:

Automation Control Systems
- Machine Automation Controllers (MAC) • Programmable Controllers (PLC)
- Operator interfaces (HMI) • Distributed I/O • Software

Drives & Motion Controls
- Servo & AC Drives • Motion Controllers & Encoders

Temperature & Process Controllers
- Single and Multi-loop Controllers

Sensors & Vision
- Proximity Sensors • Photoelectric Sensors • Fiber-Optic Sensors
- Amplified Photomicrosensors • Measurement Sensors
- Ultrasonic Sensors • Vision Sensors

Industrial Components
- RFID/Code Readers • Relays • Pushbuttons & Indicators
- Limit and Basic Switches • Timers • Counters • Metering Devices
- Power Supplies

Safety
- Laser Scanners • Safety Mats • Edges and Bumpers • Programmable Safety Controllers • Light Curtains • Safety Relays • Safety Interlock Switches